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Installation Guide for ZAP 6808 SIM

This chapter describes how to install the COSMIC ZAP C Cross
Debugger Simulator the MC68HCO8 on your host system.

¢ Preparing For Installation

¢ Verifying Installation

¢ Compiling Programs for Cross Debugging
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Preparing For Installation

Your ZAP package consists of the ZAP Debugger, installation script
files, tutorial files, and help files. To use ZAP, the following is
required:

* A PC with an Intel Pentium or compatible microprocessor.

e Microsoft Windows 95/98/ME, Windows NT 4.0 or
Windows 2000/XP operating system.

*+  CD-ROM Drive
* Hard disk drive with at least 20 Mbytes of free space.
*  Minimum of 32 Mbytes of Extended RAM

Each software CD in the package has a printed label identifying the
product, the product version number and the license serial number. In
the installation instructions that follow, we assume that your CD-
ROM drive is designated by D: and your hard disk partition by C:. If
your system uses different device names for your disks, you should
adjust the installation instructions accordingly.

Installation Process

Z AP is installed by an Installshield setup program. Throughout the
installation procedure, there is an assumed default directory in which
Z AP will be installed. This directory is c:\cosmic\zaps08. If you
install ZAP in a different directory or on a different hard disk drive,
you must substitute your specified location wherever you see
C:\cosmic\zaps08.
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Running the Installation Program

1. Insert the Cosmic Product CD into your CD-ROM drive.
A Demoshield window should automatically appear. If it
does not appear double click on “cosmic.exe” in the CD’s
root folder using a Windows file explorer.

ainstall Products
. Froduct Documentation

. Browse CD Contents

OSMIC

Software

—

2. Click on “Product Documentation” to view any of the
Product user’s manuals. Click on the “main” button to go
back to the main menu for product installation.

3. Click on “Install Products” and then click on the product
buttons you wish to install.

a) Install the compiler before installing IDEA or the
Codewright Integrator so the examples provided will
be configured properly.

b) Complete one installation before starting another.

Page 5
© Copyright 2001 by COSMIC Software



Installation Guide for ZAP 6808 SIM

An Installshield window should appear. The installation program,
allows you to select the hard disk drive and directory where ZAP will
be installed. Follow the on-screen instructions to complete the instal-
lation. If you do not specify your own installation directory, ZAP and
its associated programs will be installed in the folder
C:\cosmic\zaps08 directory.

Dongle Setup

If you received a hardware key (dongle) with your distribution
attach it to your PC at this time and follow the instructions
below to install the dongle drivers.

a) Click on the Utilities Button from the Install products
page.

b) Click on Dongle device drivers and follow the on-
screen instructions to install the necessary dongle
device drivers. The drivers are necessary in order to
use the dongle in conjunction with another parallel port
device.

c) The license file should be installed automatically from
the CD if the dongle was shipped with the package. If
you receive a license file separately via CD or email
then copy it to the \license sub folder under the product
installation.

Node Locked Setup

If you purchased a node locked license without a dongle then
install all of the software as described above and then click on
“Register Cosmic Software”. Fill out the registration infor-
mation and click on send. This will send an email with the
appropriate information to the Cosmic licensing department
and they will return a text file with the license key via email.

a) Copy the license text file (license.lic) into the license
subfolder under each of the products installed.
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Floating License Setup

If you purchased a floating license click on the “Utilities Button”
from the Install products page. Click on view “Float License
Readme” and follow the instructions to install the license manager
and clients.
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Verifying Installation

ZAP Cosmic Tools-> ZAP 6808 SIM from the Start Menu to open
the ZAP debugger . The main ZAP window should now be active.
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Choose Load from the file menu.

Select the file c:\cosmic\zaps08\examples\demo08.h08 by
clicking on it and then clicking on OK. Note: The demo
examples may need to be relinked for use with some target
systems or processors. Compare demo08.map with the
processor map and target system memory map if download
fails. ZAP should load the file and you should see either
the source (if compiled in debug) or the disassembly of the
startup routine.

Choose Step from the Debug menu
The source file CRTSL.S should appear in the source
window and the first line should be highlighted.

Choose Registers from the Show menu to open the register
window.

Choose Stepinst from the debug menu or click on the

single foot in the button bar E to step one assembly
instruction at a time. Instruction step a couple of times and
you should see the program counter (PC) in the register
window incrementing. The blue highlight which denotes
the current assembly instruction should also move down
one instruction at a time in the source and disassembly
windows.

Choose Go to Function Entry from the debug menu, select
main and click OK. The source window and the PC
should move to the first line of the main function.

Click on the Source Step button in the button bar a
couple of times and you should see the blue highlight for
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the current line of C code trace through execution one C
line at a time.

8. Double Click on the variable “count” or “swi_count” and
select monitor from the pop-up menu.

9. Click on the green light or select “go” from the debug
menu and wait a couple of seconds then click on “stop”

10. Check the values of “count” and “swi_count” in the
monitor window. The values should increase during
execution.

If you observe the behavior described with each action above then
ZAP should be configured correctly.
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Compiling Programs for Cross Debugging

The COSMIC ZAP debugger requires your application to be built
with the COSMIC C cross compiler or its equivalent, version 4.0 or
higher. To compile your C programs for full C source level cross
debugging with Z4P, you must specify the +debug compiler option
when you compile your program. The command line will have the
form: where <options> are any other compiler options you wish to

cx6808 -v +debug <options> <filel.c> <file2.c> <file3.c>

specify, <filel.c>, <file2.c> and <file3.c> are the C source
files that will make up part of the linked executable.

When you specify +debug, the compiler includes all of the necessary
cross debugging information required by ZAP. The debug infor-
mation is kept in a separate, hidden section on the host system. You
should not attempt to link the debug section explicitly.

To build an assembly file for assembly source level debug you must
use the -x assembly option. The following is an example command
line for the assembler:

ca6808 -vl -x <file.s>
OR
cx6808 -vl -ax <file.s>
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CHAPTER

1

Overview

The COSMIC ZAP source level cross debugger isafull featured MS-
Windows cross debugging environment. It isdesigned to provide a
powerful yet intuitive Windows interface for efficient cross
debugging of embedded applications. 4.0xThis chapter provides an
overview of ZAP's main features and a description of the various
target configurations available. The following sections are included:

¢ ZAP Display Windows
+ ZAP Debugging Features
+ ZAP Target Configurations
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ZAP Display Windows

ZAP isatrue MS-Windows application providing an infinite combi-
nation of display options. You can open and arrange any combination
of the following windows. You can even change each window's font
and highlight colors.

Sour ce Window
The Source window displays the C or Assembly source code
for the active function and maintains the active instruction
highlight for the current line of source code.

Disassembly Window
The optional Disassembly window displays a disassembly of
the current page of code. The disassembly display is coordi-
nated with the C or Assembly source window to provide simul-
taneous debugging of C and assembly. With ZAP, you can
even set breakpoints in the Disassembly window.

Command Window
The optional Command window gives you the option to use
ZAP'srobust command language.

Monitors Window

The Monitors window is an optional relocatable window that
displays monitored (or watch) expressions and variables. This
window allows you to point and click on monitored objects to
change their format or update their value.

Register Window
The Register window displays the current values of the CPU
registers and displays changes between commands in color.

Stack Window
The Stack window displays the current stack frame including
function arguments.

Data Windows
You can open multiple Data windows to display a memory
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dump or disassembly anywhere in your memory map.

Variable Window
The Variable window displays the address and value of all
variablesin the current scope in one of several display formats.

Toolbar

The Toolbar is arelocatable push button window providing
easy access to some of the most commonly used debugging
commands.
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ZAP Debugging Features

ZAP provides many features tailored specifically for the embedded
systems developer. The user interface is almost entirely processor
and execution configuration independent. If you are debugging code
on several processors or different target configurations your
debugging skills are entirely portable. The following sections briefly
describe the high level user interface common to all target configura-
tions of ZAP,

Non-intrusive Debugging

ZAP does not modify your code in any way. The symbol information
ZAP usesis produced in separate, transparent sections, which resides
on the host. The code you cross debug is that which you intend to
execute in your final product, not an intermediate language. You can
PROM your code or download it to the target environment directly
after debugging with ZAP (No recompiling or relinking is required).

Source Browsing

Zap's unique source browser allows you to search and view all of
your source code in multiple discrete windows. You can set and edit
breakpoints anywhere in your code without changing the source
window or the current state of execution. ZAP's powerful browser
feature also lets you quickly search and monitor variables and break-
points.

Graphical Performance Analysis

ZAP's performance analysis feature gives you a graphical represen-
tation of code coverage and MCU cycles. Code coverage can be
displayed on afile by file, function by function basis. Thisfeature
gives you arelative comparison of your codes efficiency, thus
allowing you to go back and optimize the code to get the most out of
your embedded project. (Available only in simulation version)
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C and Assembly Trace

The C and Assembly Trace feature allows you to record and playback
any sequence of C or Assembly instructions. You can move
backwards and forwards through the recorded trace one instruction at
atime or in a continuous playback mode. To help you save time, you
can even exclude functions you want to trace over. (Not availablein
all configurations see the Chapter titled “ Advanced Topics’ for
details)

Time Line Chronograms

The Chronology feature provides achronogram or graphical time-line
of function calls. A proportional bar chart is used to denote entry and
exit from afunction with relation to the total number of cycles
executed. You can display the chronology of function calls. ZAP can
even report chronology on interrupt service routines so you can keep
track of external events aswell asinternal function calls. (Not
availablein all configurations see the Chapter titled “ Advanced
Topics’ for details)

Chromacoding

ZAP provides syntax color coding of C key words, C library
functions to make it easier to follow the flow of your program.

Breakpoints

ZAP's powerful breakpoint facility lets you set an unlimited number
of breakpointsin any source window with a simple double click of
the mouse. You can attach debugger actions, user commands, and
complex expressions to any breakpoint. You can even set complex
breakpoints.

Expression Evaluation

ZAP alowsyou to evaluate and monitor variables and expressions by
double clicking on them or selecting them with the mouse.
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Single Sepping C and Assembly

ZAP's stepping facility lets you to step through your program at the C
and assembly level, step into and over function calls and perform
conditional stepping.

Automated Debugging Sessions

You can use ZAP'sfile redirection and log file management facilities
to automate debugging sessions. You can record and play back all or
part of adebugging session.

On-line Help Facility

ZAP provides an extensive Windows on-line help facility. Double
click on aC keyword, library function in the source window to open a
syntax help window. Choose On C Library from the help menu to
display alist of ANSI C functions and hypertext manual pages.

Comprehensive Debugger Command Set

In addition to the many mouse and menu features, ZAP provides an
extensive command language for those who prefer command entry to
mouse operations. ZAP’s comprehensive set of commands allows
you to cross debug your code at both the C source and Assembly
language levels.
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ZAP Configurations

ZAPisavailablein four target configurations to provide debugging
support for all phases of development. All of the ZAP debuggers
share the same high level Windows interface and command set so
thereis no additional learning curve as you progress through your
development or change to another supported environment. The
available configurations include:

Simulator Configuration

This version of ZAP integrates a CPU simulator with afull C and
Assembly source level debugger to provide adebugging environment
which doesn’t require any external hardware. Thisversion is useful
during the early stages of development when you' re trying to debug
your algorithms or when hardware is simply not available.

In-Circuit Emulator Configuration

ZAP has also been interfaced with several full featured in-circuit
emulators to provide the optimal debugging environment. This
version of ZAP is often used in the latter stages of development to
fine tune optimizations and track down the hard to find bugsin
complex embedded applications.
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CHAPTER

2

Using ZAP

This chapter describes the basic invocation and operation of the
COSMIC ZAP debugger. This chapter assumes that you have read
the Installation Guide and have properly installed the debugger and
setup the execution environment. This chapter includesthe following

sections:;

L 4
*

L 4
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Starting ZAP

ZAP Window Displays

Screen Display Options

Loading an Application (File Menu)
UtilitiesMenu

On-line Help facility
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Sarting ZAP

The easiest way to start ZAP is to locate the ZAP icon and double
click onit. Alternatively, you can select ZAP from the start menu
under Windows 95/NT. Thiswill bring up the main debugger screen
as shown below. This screen consists of the ZAP desktop, menu bar
button bar and status bar.

i

enu and Button Bar

Figure 2-1 ZAP Main Window
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ZAP Windows

In addition to the main debugger screen, ZAP uses several optional
windows to efficiently display and control the debugging process.
Each window can be opened, closed, moved and resized using
standard Windows 95/NT mouse commands. The optional windows
are available under the Show menu. Simply select the desired
window to open it and select it again to closeit.

Source Window

The Source window is the leftmost window in the main display and
accepts point and click breakpoints and expression evaluation. The
Source window displays the C or Assembly Source code for the
activefileand function and maintains the active instruction highlight
for the current line of source code. Source code is shown with bold
line numbers when assembly codeis actually produced for the source
line and gray line numbers for source lines that didn’t produce any
code (i.e. #defines, #iifdefs etc.). The Source window also provides
color coded syntax and on-line help for C keywords and C library
functions. Simply double click on any C keyword, library function
to pop-up asyntax help window. You can enable/disable syntax color
coding by selecting Syntax Coloring from the Show menu.

Button Bar

The Button Bar consists of graphical push buttons which duplicates
many of ZAP' smost heavily used commands. The button Bar can be
turned on and off by selecting Button Bar from the view memory.

Toolbar

The Toolbar provides afast convenient way to access the more
frequently used debug commands. The Toolbar option under the
Show menu controls the orientation of the toolbar dialog box.
Choose Toolbar>Horizontal or Vertical to open the toolbar with the
desired orientation. The Toolbar is completely relocatable so you can
place it anywhere on the screen.
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Command Window

The Command window is an optional rel ocatable window used to
enter and display debugger commands and output. See the Chapter
titted “ZAP Commands’ for details.

Disassembly Window

The optional Disassembly window displays a disassembly of the
current (or active) page of code. This display also maintains a
highlight on the current assembly instruction and a secondary
highlight on the assembly instructions that correspond to the active
line of C code or assembly macro. This Disassembly window also
accepts point and click breakpoints on instruction addresses.

Memory Window

The memory window is an optional relocatable window that displays
ablock of memory in one of several formats including disassembly
(code), hexadecimal, octal, binary and decimal. You can have the
ASCII representation of the memory block displayed alongside the
memory dump to help you find and monitor strings at the low level.
Memory changes between commands are highlighted so you can
easily track memory modifications as your program executes. You
can modify memory by clicking on the desired data value and typing
anew value. You can also choose to disassemble memory by
selecting Code in the Memory Configuration window. You can set
breakpoints in the disassembly by double clicking on the assembly
address.

Monitors Window

The Monitorswindow isan optional relocatable window that displays
monitored (or watch) expressions and variables. Thiswindow allows
you to point and click on monitored objects to change their format or
update their value.
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Register Window

The Register window is an optional relocatable window that displays
the current values of the CPU registers and displays changes between
commandsin color. Thisdisplay allowsyou to click on any register

name to change its value to an application symbol or double click on
it's value directly to change it explicitly from the keyboard.

Sack Window

The Stack window is an optional rel ocatable window that displaysthe
current stack frame including function arguments. You can double
click on afunction name in the stack frame to open up a source
browser window.

Satus Bar

The optional status window isasmall grey bar located below the
source window Thiswindow displays the current status of the
system. (i.e. running, stepping etc.)

Variable Window

The Variable window is an optional relocatable window that displays
the address and value of all variables in the current scope in one of
severa display formats.
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Screen Display Options

ZAP dlowsyou to customize the screen layout, text fonts and colored
highlights of the various screen displays. All of these attributes can be
changed using the Setup and Windows Menu. To save changes to
window layout fonts and color highlights choose Save Config On Exit
from the Setup menu.

Windows M enu

ZAP usesthe standard Window 95/NT display options Free, Cascade,
Horizontal Tile and vertical Tile. These options are found under the
Windows menu. The Windows menu also maintains a history list of
al open windows including those minimized. Choose an open
window from the history list under the Windows menu to bring it to
the foreground and make it active.

Free Allowsyou to place and size all windows by hand
with new windows opening with the default size
and on top of other windows.

Cascade Displays all windows cascaded from top left to
bottom right with new windows cascaded on top
asthe last window.

Horizontal Tile - Displays all windows in awider horizontal
size. Each window is proportionally sized to fill
the entire main the window without overlapping.
New windows are added from the top left corner
and push the other windows down and then up to
the next column to keep the display proportional.

Vertical Tile- Displaysall windowsin ataller vertical size.
Each window is proportionally sized to fill the
entire main window without overlapping. New
windows are added from the top left corner and
push the other windows to the right and then
down to the next row to keep the display propor-
tional.
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Setup Menu

L oad Option (Code and Symbols)

This option alows you to choose whether to load the code
portion of theimage. In some case, typically when a hardware
version is used, you may load the code portion via another
method such as a serial programmer. In this case, you can
choose to load only the symbols through ZAP and debug the
matching code which is already available in the target system.
The default is to load both the code and symbols.

NOTE

In al cases symbols are not loaded to the target system. All
symbols are loaded and kept on the host. If you plan to load
only the symbolsit is required that the code image and the
symbol image are created from the same executable (i.e. linker
output). If they do not match the behavior is undefined.

Colors

Each color option item listed under the options menu opens a
Windows color pallet for selecting the desired color. Simply
click on the desired color and click OK to change the color.

Events

Changes the highlight color for active and suspended
events. This highlight appears on the C line number in
the source window when a breakpoint is active or
suspended. The highlight also appears in source and
event browser windows.

Disassembly

Changes the color of the disassembly highlight in the
disassembly window. This highlights the assembly
instructions that correspond to the current line of C code.

Instruction
Changes the color of the highlight for the current
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assembly instruction or program counter in the disas-
sembly window.

Memory
Changes the color of modified datain the Memory
window.

Source
Changes the color of the highlight for the current line of
C code in the source window.

Search
Changes the color of the highlight for linesfound in a
search. the current line of C code in the source window.

Syntax Coloring

ZAP provides syntax color coding of C key words, C
library functions and kernel objects to make it easier to
follow the flow of your program. If you prefer you can
change the color used for a particular object or disable
color coding altogether. To enable/disable al syntax
coloring choose syntax coloring from the view menu.
To change a particular syntax color choose the syntax
type that you want to change from the Syntax coloring
submenu.

C Comments

C Key words

Library Functions

Mnemonics - (Assembler mnemonics)

Fonts

The font option allows you to change all of the fonts to your
own taste or selectively change the fonts for the different
windows. Each selection will open up a Windows font dialog
box which allows you to choose any available font.

All Changes the default font for al the windows.
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Browser Changes fonts for al the browser windows.
Commands Changes Command window fonts.

Memory Changes the fonts for the data or memory
dump window.

Disassembly Changes the font for the disassembly
window.

Monitors  Changesthe font for the Monitor window.
Registers  Changes the Command window fonts.

Source Changes the font for the C source code
window.

Sack Changes the font for the Stack display
window.

Key Binding (Keyboard Short-cuts)

ZAP s key binding facility allows you to attach or bind short-
cut keys ZAP commands and tasks. Simply select click on the
function key by itself or in combination with the <Shift> and
<Control> keys and then choose a ZAP function from the
binding pull down list and then click OK or on another function
key to save. Key bindings are saved in the ZAP initialization
file (.ini) when the configuration is saved. This mechanismis
in addition to the standard Windows shortcuts denoted by the
underscored letter in each command.
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Figure 2-2 Key Binding Setup Box

Path Editor

The path option is used to define the search path to the source
files. By default, ZAP searches the directory where the
debugger isinstalled. Using the PATH editor you can browse
through the directory structure to add the appropriate search
paths. Simply double click on the desired path and click on
Append, Add before or Add after to place the current path in
the desired place in the search path. ZAP searches from top to
bottom in the Path Editor to find source files.
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Figure 2-3 Path Editor

Interrupts

ZAP SIM provides a mechanism to simulate interrupts. This
menu item is used to configure the interrupt table and the type
of interrupt source. See the section “Simulating Interrupts’ in
the chapter titled “ Advanced Topics’ for details.

Default Int Format

This option specifies the default display format for the variable
browser window. Choose binary, decimal, octal or
hexadecimal.

Save Config

This option saves ZAP's configuration immediately. The
configuration save includes the location and size of the
following windows if they’ re open when performing the save.
The Main ZAP window, Disassembly, Monitors, Regsters,
Stack, Status and Toolbar. ZAP also savesthe fonts, highlights
and colors.
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Save Configuration on Exit

This menu item is used to turn the Save Config on Exit option
on and off. When the menu item ison (checked) ZAP will
save the location and size of the following windows if they’re
open when exiting ZAP. The Main ZAP window, Disas-
sembly, Monitors, Regsters, Stack, Status and Toolbar
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L oading an Application
FileMenu

L oad

The Load option opens up the load dialog window as shown bel ow.
You can browse and select the load file by choosing afolder from the
“Look In” pull down menu. The debugger accepts an absol ute object
file from the appropriate COSMIC compiler (i.e. output file from the
linker). Thisfile should be built with the +debug compiler option to
include C source level debug information. For Assembly source level
debugging, use the -x assembler option. Once the file has finished
loading, the program counter is set to the address of the symbol
__stext or the beginning of the first segment in the link fileif the
symbol __stext is not defined. Thisistypically the address of the
beginning of the assembly level startup routine (crts.s or crtsi.s),
which is used as the default reset vector.

Load
Look in: I 23 bus_state_analyzer_test
12232
File name: II:usa_EIE!_azBE.hDB Open I
Files of type: IHEIE! Files[* h0g) j Cancel |

Figure 2-4 Load Menu
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Application Map

Choose application map to display the application segments along
with their corresponding starting and ending addresses and segment
sizes.

L oad and Save L ayout

ZAP Allows you to save and restore the screen layout at any time.
The save layout command saves the size and | ocation of thefollowing
windows: Source, Disassembly, Registers, Stack, Command,
Monitor and the main ZAP desktop window.

L oad and Save Session

The save session command is a superset of the save layout command.
In addition to the layout, the save session command savesthe last file
loaded, the contents of the monitor window and any data windows
and their addresses. The load session command opens all of the
windows in the layout and then |oads the saved application. Once the
application isloaded ZAP will then fill the monitor window with the
saved variables and open any saved data windows to their proper
addresses. A session file can be loaded from a command line or
shortcut using the -soption. e.g. zap.exe -sfilename.ssn

About ZAP

The File menu item About ZAP provides a dialog box containing the
configuration, version number and copyright for ZAP.

Exit
The exit menu command closes ZAP and all windows associated with
the current invocation and optionally saves the configuration.
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Utilities M enu

ZAP alowsyou to integrate and operate your favorite editor and
make facility with the compiler and debugger. You can access
severa toolsaswell aDOS shell from a convenient button bar or pull
down menu. To configure the button bar Choose Configure from the
Utilities Menu to open the Tool Editor.

Configure Tools

The Tool Editor allows you to call any DOS or Windows editor by
entering the appropriate editor commandsin the Edit field. To call or
switch to an editor with the current source file use the % character to
denote the current sourcefile.

Call Editor

To configure an editor simply enter the appropriate command
to start the editor in the Editor field of the Tool Editor. To
open or switch to the editor from ZAP select Call Editor from
the Utilities Menu to invoke the desired editor.

Edit Current File

To setup an editor to automatically open the source file
currently active in ZAP add the editor command followed by
the % character to denote the current file. Click on the appro-
priate button or select Edit Current File to open the editor with
the current sourcefile.

Compile

Setup the compiler command line in the Compile field of the
Tool Editor including all desired compile time options
followed by a % character. To compile the active sourcefile
click on the Compile button or choose Compile from the
Utilities Menu.

Compile Debug

Same setup as Compile with the addition of the debug option to
provide source level debug information. To compile choose
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Compile Debug from the Utilities Menu or click on the
Compile Debug button.

Build

The Build command can be used to execute a makefile or link
the current application. To configure the build command enter
the desired command in the Build field. To execute the build
command select Build from the Utilities menu or click on the
Build button.

DOS Shell

To open aDOS Shell. Click on the DOS icon or select DOS
Shell from the Utilities Menu.

Edit dewrighthes |
“::'"" d:hcwrightiom % |
Cnmpiln cehflS  vls X |

t‘;:"_'“ esBBO5 vis el % |

Budd cink - ousile k0B Enkiik. ink] |

Wie X a5 e Cusienl File Name

(=] (o]
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On-line Help Facility

ZAP provides an extensive help facility. ZAP provides help on C
language syntax and C library syntax aswell as how to use ZAP.

Help on Using ZAP

Choose On ZAP from the help menu to display alist of help topicsfor
ZAP. Double click on any subtopic to view manual pages on the
topic.

Help on C Library

Choose On C Library from the Help menu to display alist of C
libraries. Double click on any function name to display a manual
page describing the syntax of the function.

Help on C Syntax

Double click on any C keyword or library function to open up a
syntax description window.
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CHAPTER

3

Program Execution

This chapter covers the many different ways to control program
execution, including:

L 4
L 4

L 4

Page 3-1

Start and Stop Execution

Single Stepping

Reset and Restart

Events and Breakpoints

Out of Bounds Checking (Alarms)
Activate and Deactivate Functions

Browser Menu
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Sart and Stop Execution

Once an application is loaded into ZAP you have several options for
executing your code. These options are found under the debug menu
and on the Toolbar.

Nor mal Execution

Normal execution is the continuous real-time execution of the appli-
cation (except with simulation of course). ZAP updates any active
windows whenever execution halts.

Mouse and Menu

To start or resume execution type g when the Source window is
active or choose Go from the Debug Menu, Button bar or
Toolbar. Thiswill start execution from the current PC and
continue until an active breakpoint is reached or you select
Sop from the Main menu.

Go Till SourceLine Short-cut

If you want to execute the program until a particular sourceline
simply hold down the control key and double click on the
source line number. This can be done from any source window
including C or assembly source browser windows.

Go Editor

The Go Editor allows you to execute your code until it reaches
aspecific file, function, line number, address. Choose Go Till
under the debug menu to open the Go Editor.

« Double click on afunction name or source file to execute
until the specified function or source file is entered.

« Enter asourceline number in the Line Box to execute until
thelineis reached.

« Enter an address in the address box to execute until the
address is reached.
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Figure 3-1 Go Editor

Command Window

Type g in the command window to start or resume execution.
The g command accepts one of two possible arguments. You
can enter either anumber of C linesto be executed or the C line
number to execute to. See the g command in the “ ZAP
Commands’ chapter for details.

Sop execution
Mouse and Menu
You can stop execution at any time by clicking on Sop or
typing escape in the Main menu. When the program stops al
active or dynamic windows are updated and refreshed.
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Single Sepping

Single stepping allows you to execute one Disassembly instruction or
source line at atime and monitor changes to the system. All active
and dynamic windows are updated after each single step. ZAP offers
severa different types of single stepping for greater flexibility. You
can step at the source level or disassembly level, step into or over
function callsand perform conditional stepping. ZAP coordinatesthe
source display with the disassembly display using color coded
highlight bars. The current source line and disassembly instruction
(PC) is highlighted in the source and disassembly window respec-
tively. ZAP also provides an additional highlight bar which covers
the assembly instructions that make up the current line of source
code. These highlights are continuously updated with all of the single
step methods described below.

Mouse and Menu

e To step one source line and step into active functions
Choose Sep from the Debug menu or Toolbar or type s
when the ZAP Source window is active.

» To Step one source line and step over function calls;
Choose Sep Over from the Debug Menu or Sep O from
the Tool bar.

* To Step one disassembly instruction and step into
functions; Choose Sep Instr from the debug menu or Sepl
from the Toolbar. You can also type swhile the Disas-
sembly source window is active to step at the assembler
level.

Sep Editor

The step editor allows you to perform multiple single steps and
conditional single stepping. Choose step until under the debug
menu to open the step editor.

* Click inthe Assembler Box to enable and disable assembly
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level stepping. The default is source level stepping.

« Double click on afunction name or source file to single
step until it enters the specified function or source file.

»  Enter anumber in the count box to perform multiple single
steps from the current program counter.

e Enter aC line number in the Line box to step until the line
is reached.
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Funchon Filw
SF & & | (41 |
clstari I ook ¢ 1
ol s Ty Rl m dkxire.c
Ml el i
] T =00
main [T
paeil EPEEE
pachai CARRR ¢
TS 19 cinshc
mciidre ovdwme 0000 | |
Db e | - vl i | Eirip |
acinlar & guharc 4
Crmigl |
Tnsk ] £ Lne |
] Asesmler

Figure 3-2 Sep Editor
Command Window

The step command single steps one line of source code. The
step command accepts two optional arguments. The following
examples demonstrate some common uses of the step
command.

See the step command in the * ZAP Commands’ chapter for
more details.

» To step one source line and step into active functionstype s
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or step in the command window.

» To step multiple source linestype s# where#isthe
number of source lines to be executed.

» Type soor ostep to step one source line and step over
function calls.

« Type sioristep to Step one disassembly instruction and
step into functions.

» Type so put() to step over function calls until the function
put() is encountered.
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Reset and Restart

Reset

Choose Reset from the debug menu to reset the processor or
processor simulation.

In ssimulation (ZAP SIM), this option sets the PC to the reset vector
and sets al of the MCU registersto their reset state.

Go from Reset

Choose “ Go from Reset” from the Debug Menu to reset the
processor or processor simulation and then issue a Go command to
start execution. This option does not affect any events.

Restart

The Debug menu item Restart sets the PC to it’s original value after
loading the current application. This command does not affect any
other registers or events.
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Events and Breakpoints

Events and breakpoints are used to control program execution based
on the state of the system. Code Events include breakpoints and
watchpoints. ZAP SIM provides Data events and Out-of-Bounds
alarms for even more control over program execution. Data events
include data breakpoints, data watchpoints, Memory Alarms, PC
Alarms, and Stack Alarms.

Code Events

Code events include breakpoints and watchpoints. A breakpoint is
used to stop execution so that the system can be analyzed. A watch-
point is used to temporarily stop execution, perform an action and
then continue execution.

Watchpoint

A watchpoint is used to temporarily stop execution, perform an action
and then continue execution. A watchpoint is the same as a break-
point except that execution resumes after the action is finished. To
set awatchpoint choose “watchpoint” in the “ Code Event Editor” or
use the “Watch” command. Seethe chapter titled “ ZAP Commands’
for details. The specification and options for watchpoints are
identical to that of breakpoints. Breakpoints can be converted back
and forth to watchpoints by selecting the watchpoint or breakpoint
box in the code event editor.

Breakpoints

A breakpoint is an event that causes execution of your program to be
interrupted so you can examine the state of the system. You can set an
unlimited number of active breakpoints on any C source line,
address or data object. You can also associate debugger commands,
user commands and complex expressions to any breakpoint. There
are several methods for manipulating breakpoints, choose any of the
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following methods.

Setting/Editing Breakpoints

Mouse and Menu

Double click on any valid line number in the Source
window to set an unconditional breakpoint on aline of
source code. A valid line number refersto aline of source
code that actually produced assembly code and is shownin
bold.

Double click on any bold line number in a source browser
or Event Browser window (See Browsing optionsfor more
information).

Double click on an address in the Disassembly window to
set a breakpoint on an address.

Command window

The b command is used to set and display breakpoints. The
breakpoint command accepts the following syntax:

break [/<options>] [<location>] [{<action}]

See The break command in the “ ZAP Commands® chapter for
a complete description.

Page 3-9

Type b:line# in the command window to set a breakpoint
on the line number in the current source file.

Type b function() in the command window to set a break-
point on every line of the function().

Type b/4 main(): 8 to set a breakpoint on line 8 of the
function main that will only halt execution every fourth
time thelineis executed.

Type b foo():3{u i 2} to set abreakpoint on line 3 of
function foo() and perform the action specified inside the
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curly braces. In this case, the action isto update variable i

to 2 when the breakpoint is taken.

Deactivating/Activating Breakpoints

ZAP alows you to deactivate or suspend any breakpoint without
removing it from the system. You can then selectively activate them
as needed. When a breakpoint is deactivated it will not halt or
interfere with execution. Note: The breakpoint highlight will change
colors when you activate and deactivate a breakpoint. Choose any
one of the following methods to activate and deactivate breakpoints:

Mouse and Menu

To activate or deactivate a breakpoint double click on a
breakpoint line number in the source window or source
browser window while holding down the shift key.

Double click on an active breakpoint and choose on/off
from the pull down menu to activate or deactivate the
breakpoint.

Choose Browse from the Events Menu and double click on
abreakpoint while holding the shift key to activate or
deactivate the breakpoint.

Choose Browse from the Events Menu and double click on
abreakpoint. Choose on/off from the popup menu to
deactivate or activate the breakpaint.

Choose Events from the Browser menu and double click on
an active breakpoint while holding the shift key to
deactivate the breakpoint.

Choose Events from the Browser menu and double click on
an active breakpoint. Choose on/off from the popup menu
to deactivate or activate the breakpoint.

Command Window
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The Code Event Editor is not available as a Command Window
option.

Deleting Breakpoints

Breakpoints are completely removed from the system by deleting
them. Choose any of the following methods to delete a breakpoint.

Mouse and Menu

To delete a breakpoint double click on an active or
suspended breakpoint line number in the source window or
source browser window while holding down the control

key

Double click on an active or suspended breakpoint line
number in the source window or source browser window
and choose Delete from the popup menu

Choose Browse from the Events Menu and double click on
a breakpoint while holding down the control key to delete
the breakpoint.

Choose Browse from the Events Menu and double click on
abreakpoint. Choose Delete from the popup menu to
delete the breakpoint.

Choose Events from the Browser menu and double click on
a breakpoint while holding the control key to delete the
breakpoint.

Choose Events from the Browser menu and double click on
abreakpoint. Choose Delete from the popup menu to
delete the breakpoint.

Command Window

To delete a breakpoint from the command window you can use
the del command. The following examples demonstrate the
use of the del command to delete breakpoints. See the del
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command in the “ ZAP Commands’ Chapter for details.

« Typedel #where # is the breakpoint number as shown to
the left of abreakpoint in a Event Browser window.

* Typedel * to delete all of the breakpoints from the system.

Code Event Editor

The Code Event Editor can be used to set, suspend and delete
breakpoints. The Code Event Editor also letsyou attach an
action to a breakpoint or create awatchpoint. The Code Event
Editor can be opened in several ways. Choose any one of the
following to open the Code Event Editor:

»  Choose Code Event from the Events Menu to open up the
Code Event Editor.

* Choose Browse from the Events Menu, double click on a
breakpoint and choose Edit from the popup window.

» Double click on any breakpoint in the source window and
choose Edit from the popup menu.

» Double click on abreakpoint in any source browser
window and choose Edit from the popup menu.

e Choose Events from the Browser menu, double click on a
breakpoint and choose Edit from the popup menu.

Setting Breakpoints

To set a breakpoint using the Code Event Editor choose the
desired conditions and click on OK to set.

» Choose or enter afunction name to set a breakpoint on
every line of the function or on function entry.

* Choose Whole to set a breakpoint on every Clinein
the selected function.
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e Choose On Entry to set a breakpoint on the entry of
the selected file or function.

»  Choose or enter afilenameto set a breakpoint on every line
of the sourcefile.

»  Choose Breakpoint to stop execution when the conditionis
met.

»  Choose Watchpoint to silently stop execution, execute the
action (if any) and resume execution.

* Hit Count Box - Enter anumber in the Hit Count Box to
specify the number of times the breakpoint will be
executed before execution is halted.

» Choose Active or Suspended from the Status box to
activate or suspend an the breakpoint or click the ON/OFF
button.

» Action Box - Enter any ZAP command or combination of
ZAP commands in the action window to attach an action
to the current breakpoint. See the chapter “ ZAP
Commands’ for more infor mation about ZAP Commands.
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Figure 3-3 Code Events Editor
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Displaying and Editing Breakpoints

Active and suspended breakpoints are denoted by a color highlight
over the source line number or assembly address in the Disassembly
window or any Browser window. To display acompletelist of al
existing breakpoints choose Browse from the Events Menu or choose
Events from the Browser menu to open up the Event Browser
window. You can click on any breakpoint listed in this window to
activate, deactivate, delete or edit it. See the Breakpoints section of
this chapter for more information on activating, editing and deleting
breakpoints.

Data Events

Data events include data breakpoints and data watchpoints. A data
breakpoint is used to stop execution when aread or write accesssis
detected at a particular application variable so that the system can be
analyzed. A datawatchpoint isused to temporarily stop execution,
perform an action and then continue execution.

Data Watchpoint

A datawatchpoint is used to temporarily stop execution, perform an
action and then continue execution. A datawatchpoint isthe same as
a data breakpoint except that execution resumes after the actionis
finished. To set a data watchpoint choose “watchpoint” in the “Data
Event Editor” or use the “dwatch” command. See the chapter titled
“ZAP Commands’ for details. The specification and options for data
watchpoints are identical to that of data breakpoints. Data Break-
points can be converted back and forth to Data watchpoints by
selecting or deselcting the watchpoint box in the Data Event Editor.

Data Breakpoints

A data breakpoint is an event that causes execution of your program
to be interrupted when an access is made to an application variable.
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Data breaks can be set to trigger when any accesss of the variableis
detected or when either aread or awrite accessis detected. You can
set an unlimited number of active data breakpoints on any C appli-
cation variables. When the system halts execution all open and
dynamic windows are updated. You can also associate debugger
commands, user commands and complex expressions to any break-
point. There are several methods for manipulating data breakpoints,
choose any of the following methods.

Setting/Editing Data Breakpoints
Mouse and Menu

» Doubleclick onany valid C variable in the Source window
and select either Access Break, Read Break or Write
Break.

Command window

The dbreak command isused to set and display breakpoints.
The breakpoint command accepts the following syntax:

dbreak [/<options>] <variable> [{<action}]

See the dbreak command in the “ ZAP Commands” chapter for
a complete description.

Data Event Editor

The Data Event Editor can be used to set, suspend and delete
data breakpoints. The Data Event Editor also letsyou attach an
action to a breakpoint or create awatchpoint. The Data Event
Editor can be opened in several ways. Choose any one of the
following to open the Data Event Editor:

*  Choose Data Event from the Events Menu to open up the
Data Event Editor.

* Choose Browse from the Events Menu, double click on a

Page 3-16
© Copyright 1999 by COSMIC Software



Program Execution

breakpoint and choose Edit from the popup window.

Double click on any breakpoint in the source window and
choose Edit from the popup menu.

Double click on a breakpoint in any source browser
window and choose Edit from the popup menu.

Choose Events from the Browser menu, double click on a
breakpoint and choose Edit from the popup menu.

Setting Breakpoints

To set abreakpoint using the Data Event Editor choose the
desired conditions and click on OK to set.

Page 3-17

Choose or enter a variable name and file to set a data
breakpoint on that variable.

Hit Count Box - Enter a number in the Hit Count Box to
specify the number of times the breakpoint will be
executed before execution is halted.

Choose Active or Suspended from the Status box to
activate or suspend an the breakpoint or click the ON/OFF
button.

Action Box - Enter any ZAP command or combination of
ZAP commands in the action window to attach an action
to the current breakpoint. See the chapter “ ZAP

Commands” for more information about ZAP Commands.
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Figure 3-4 Data Events Editor
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Out of Bounds Checking (Alarms)

ZAP SIM offeres an optional bounds checking mechanism. Each
memory access, instruction fetch and stack access can be checked
against atable to determine if the program execution iswithin
expected bounds.

Memory Alarm

The memory alarm is typically used to detect when a program
accesses (reads/writes) amemory area outside of the simulated target
system’s memory map. Choose “Events->Memory Alarm” to open
the setup window for the memory alarm.

Satus

choose either on or off from the status section of the memory
Alarm Setup Window. It is necessarry to reset the status to
“on” after each memory alarm.

Map

The Map window displays the address ranges to be tested.
Several address ranges may be specified and tested. To enter
an address range type an addressin the “Low” and “High”
boxes and click on “Add” to add the address range to the Map
display. If youwant ot test for addresses outside the specified
address range click on “Invert” before adding to the Map
display. The set of address ranges can be tested together using
alogical “AND” or alogical “OR” by seselecting the appro-
priate option to the left of the Map display. To clear the entire
Map Window click on the“Clear” button. To delete one of the
memory address ranges from the Map display, click on the
address range to select it and then click on the “Remove”
button.

Break
Click on Break to stop execution when amemory alarm is
detected. By default, ZAP will continue to execute once the

Page 3-19
© Copyright 1999 by COSMIC Software



Program Execution

Alarm is aknowledged.

Defaults

Click on the “Default” button to have ZAP create a default set
of memory alarms using the application memory map as a
template. The default is set to any memory addresses outside
of the memory map of the loaded application. e.g. If the
current application has the following memory map, then the
default memory alarms will be set to go off when memory is
accessed outside of all of the segmentslisted. e.g. Anaccessto
an address between 0x0 and 0x49 would cause an alarm to be
issued.

5 Map Ml E3

Jhss BxBB0A @x@AaBd (515 hytes)
text BxfBB0  Bxf@6T (105 hytes)
.const Bxffce Offff (49 hytes)

Figure 3-5 Application Map

Thefollwing “Memory Alarm” setup is the default for the appli-
cation map shown above. i.e. A memory alarm will be issued if a
read/write access is detected outside of all of the listed address
ranges. 0x0-0x800, 0xFO00-0xF069, and OXFFCE-OXFFFF
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Figure 3-6 Memory Alarm Setup Window
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PC Alarm

The Program Counter (PC) alarm is typically used to detect when a
program tries to execute at an address that is outside of the simulated
target system’s code memory map. Choose “Events->PC Alarm” to
open the setup window for the PC alarm.

Satus

choose either on or off from the status section of the PC Alarm
Setup Window. It isnecessarry to reset the status to on after
each PC alarm.

Map

The Map window displays the address ranges to be tested.
Several address ranges may be specified and tested. To enter
an address range type an addressin the “Low” and “High”
boxes and click on “Add” to add the address range to the Map
display. If youwant ot test for addresses outside the specified
address range click on “Invert” before adding to the Map
display. The set of address ranges can be tested together using
alogical “AND” by selecting the option to the left of the Map
display. To clear the entire Map Window click on the “Clear”
button. To delete one of the memory address ranges from the
Map display, click on the address range to select it and then
click on the “Remove” button.

Break

Click on Break to stop execution when a PC alarm is detected.
By default, ZAP will continue to execute once the Alarmis
aknowledged.

Defaults

Click on the “Default” button to have ZAP create a default set
of PC alarms using the application memory map as atemplate.
The default is set to any addresses outside of the code (.text)
and const space. Note the interrupt vector tableistypically
stored in a const segment because it’s often written as an array
of constant function pointers. Thefollwing “PC Alarm” setup
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isthe default for the application map shown above in figure 3-
5. i.e. A PCaarmwill beissuedif aninstruction fetch is
detected at an address outside of al listed address ranges:
O0xFO000-0xFO6A, and Oxff CE-0x10000.

Pc Alarm

hdap
O

Status: & On 0 Off

Clear | Bermowve |
=
=

> And

Low I High I [ Invert

I[0:4000. 0f063]
I[0ffe..0x10000]

¥ Break

Add

Cancel
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Figure 3-7 PC Alarm Setup Window
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Sack Alarm

The Stack alarm is used to detect if the stack pointer is used with an
address outside the specified address range. Typically, you want to
set the high addressto theintial stack pointer and the low address to
an address above the highest global variable address. Thisisoftenthe
end of the .bss segment +1. If ZAP detects that the Stack pointer’s
valueis outside the specified range then a Stack Alarm will beissued.
Thisis useful to help detect if the stack crashes into the global
variable space. Choose “Events->Stack Alarm” to open the setup
window for Stack Alarm.

otack Alarm |
Status ﬁ'gn - Off
Lo |teal3
[~ Break
High | Dt
Ok Cancel |

Figure 3-8 Sack Alarm Setup Window
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Activate and Deactivate Functions

ZAP gives you the option to selectively activate or deactivate
functions you want to debug. When afunction is deactivated you can
no longer step into the function or monitor local variables and the
function will not be included in a source trace display. Thisalows
ZAPto operate more efficiently and eliminates unwanted information
in the source trace. By default, ZAP activates al functionsin your
application that are compiled with the debug option. The status of
each function islisted in the first column of the Function Browser
Window. An activated function isindicated by (on) and adeactivated
function is denoted by an (off) tag.

Mouse and Menu

To activate and deactivate functions simply double click on the
word (on) or (off) in the first column of any function browser
window.

Command Window

To activate a function use the activate command a. Thea
command uses the following syntax. For more information see
the a command in the “ ZAP Commands’ chapter.

activ <name_list>

To deactivate a function use the deactivate command da. For
more information see thed command in the“ ZAP Commands’
chapter

deact <name list>

Where <name_list> is one or more function names to be
activated. The activ and deact commands also accept the
standard wildcard character (*) to denote all functions. For
example:

1. Typedeact foo() to deactivate the function foo().

2. Typeactiv foo() to activate the function foo().

3. Typedeact * to deactivate al the functionsin the current
application.
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Browsar Menu

ZAP s unigue browser menu lets you quickly search and monitor
sources, breakpoints, data objects or any memory location.

Event Browser

The Event Browser window displays alist of all existing Events
(active and suspended) Thisincludes both data and code breakpoints
and watchpoints. You can click on any event to activate/deactivate,
edit or delete. See the section on Events for more information on
setting and editing events.

m

Figure 3-4 Event Browser Window

Sour ce Browser

Zap's unique source browser allows you to search and view al of
your source code in multiple discrete windows. You can set, edit and
delete breakpoints anywhere in your code without changing the
source window or the current state of execution. Thisis done by
double clicking on C line numbers. There are several different ways
to browse your source. Choose any of the following:

File Browser

e ChooseFile List from the Browse Menu to open the File
Browser window. Thiswindow contains alist of all the
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source files that make up the loaded application. You can
double click on any source file name to open asource
browser window containing the selected source file.

m

Figure 3-5 File Browser Window

File Browser Dialog

» Select Filefrom the Browse Menu to open the File
Browser dialog box. The dialog box containsalist of all
the source files that make up the currently loaded appli-
cation. Choose any source file and click OK to open a
source browser window containing the selected sourcefile.
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Fiis

(Humn o

Figure 3-6 File Browser Dialog Box
Function Browser

* Choose Function List from the Browse menu to open the
Function Browser window. Thiswindow contains alist of
all the source files and functions that make up the loaded
application. You can double click on any source file or
function name to open a source browser window
containing the selected source file or function.

Page 3-28
© Copyright 1999 by COSMIC Software



Program Execution

Figure 3-7 Function Browser Window

Function Browser Dialog

e Select Function from the Browse Menu to open up the
Function Browser dialog box. The dialog box contains a
list of al the source files and functions that make up the
loaded application. Select any source file or function and
click OK to open up a source browser window containing
the selected function.

[= ) [e=] (o] [ ]

Figure 3-8 Function Browser Dialog Box
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Any Source

Choose Any Sour ce from the Browse Menu to open a standard
Windows browser dialog. You can view any file on your
system. If you open afilethat is part of the loaded application
then the C line numbers will be black and you can set break-
pointsinthefile. If thefileisnot part of the loaded application
then the line numberswill be gray and the file istreated asread

only
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Figure 3-9 Any Source Browser Dialog Box

Memory Browser

The memory browser allows you to examine any valid memory
locationsin several formats including a disassembly.

. Choose M emory from the Browse Menu and select
Data in the Memory Window Configuration dialog
box to display or dump memory.

. Choose M emory from the Browse Menu and select
Code inthe Memory Window Configuration dialog
box to disassemble a block of memory.

See Displaying and Updating Memory in the chapter 5 (Monitoring
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Application Data) for more details on displaying memory.

Variable Browser

The variable browser allows you to view all of the variablesin
the loaded application. There are three different formats you
can useto display the variable information. The Brief format
displaysthe variable name and type. The Standard format lists
the variable name, type and value and the Full format displays
variable name, type, value and address. Thereareaso four
different display options as described below.

. Choose In Current Function submenu to display all
variables local to the current function.

. Choose In Current File submenu to display al static
variablesin the current file scope, global variables
declared in the current file and all variables local to
the current function.

. Choose In Glabal List to display all variablesin the
current scope including extern globals, statics and
locals.

Page 3-31
© Copyright 1999 by COSMIC Software



Program Execution

Cross Reference Browser
The Cross Reference Browser displays the calling tree for application

functions.

Function Cross Reference

This dialog window allows you to choose a particular function
to display the cross reference information. Click on afunction
name to open a Cross Reference window.
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Figure 3-10 Function Cross Reference Dialog

Cross Reference Window

The Cross Reference Window displaysthe function calling tree
for aparticular function. Double click on a colored function
name to display the cross reference tree for that function.
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Figure 3-11 Cross Reference Window
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Symbol List Browser (sorted)

The Symbol List Browser provides alist of all global C and
Assembly symbols sorted by address or alphabetically by name.
Double click on any file name to display a source browser window.
Double click on any symbol name and select from the following:

Address of Displays the address of the symbol

Evauate as Displays the value of the symboal in byte,
word or long format.

Update as Allows you to update the contents of the
symbol asa byte, word or long value.

Set Breakpoint  Sets a breakpoint at the symbols address.
Show Code Displays a disassembly of the symbols

address.
Show Data Provides a data dump staring at the address
of the symbol.
= e 0B
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Figure 3-12 Sorted Symbol List
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Symbol Browser

The Symbol Browser window allows you to quickly search through
the symbol table to find the address of a symbol. Simply type the
symbol name or a part of the nameto search thelist. Click on the
symbol to display the address.
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Map

Choose Map to display the application segments along with their
corresponding starting and ending addresses and segment sizes. This
isidentical to selecting Application Map from the File menu.
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CHAPTER

A

Monitoring Application Data

ZAP offers several advanced features to help you optimize your C
code aswell astrack down those hard to find bugs. This chapter
includes the following sections:

+ Monitoring Variables and Expressions
¢ Updating Variables

¢ Evaluating Expressions

+ Displaying and Updating Memory

¢ Evauating Assembly Symbols

¢ Displaying and Updating Registers

+ Displaying the Stack Frame
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Monitoring Variables and Expressions

ZAP provides an extensive monitoring facility. You can monitor or
watch variables one at atime in the Monitors window or view all the
variablesin the current scope in the Variable window. Both windows
are updated each time program execution is halted.

M onitors Window

Choose Monitors from the show menu or simply monitor a variable
or expression and the Monitors window will automatically open.
ZAP dlows you to monitor as many variables as you want and
change the display format of any variable.

Adding Monitors

There are severa different ways to monitor variables and
expressions. Choose any of the following methods.

Mouse and Menu

To monitor or watch a variable, double click on a variable
name in the source window and choose Monitor from the

pop-up menu.

To bypass the pop-up window, double click on avariable

name while holding down the control key.

Drag and Drop - Right Click on the variable name and drag
it to either the monitor window or it’s icon on the button
bar.

To monitor an expression, select the entire expression by
dragging with the left button and choose Monitor from the
pop-up menu.

To bypass the pop-up window, select the expression while
holding down the control key.

Command Window

Use the monit command with the variable name or expression
to add it to the Monitorswindow. The following examples
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demonstrate some common uses of the monit command. For
more detailed information see the monit command in the* ZAP
Commands’ chapter.

Type monit i to monitor the variablei.

Type monit /X i to monitor the variablei in
hexadecimal format.

Type monit &i to monitor the address of variablei.

Typemonit i+1 to monitor the value of the
expression “i+1"

Type monit /s buffer to monitor the variable buffer
asastring.

Variables and expressions must be in the current scope to be
evaluated or monitored.

NOTE

Monitor For mat

ZAPdisplaysall variablesin their declared formats by default.
However, you can change the format by double clicking on
any variable name or expression in the Monitors Window and
choosing aformat from the pop-up submenu.

Deleting Monitors

* Todeleteamonitor simply double click on avariable name
or an expression in the Monitors window and choose
Delete from the pop-up window.

Address of SourceLines

To display the address of any active line in the source window or
source browser window choose Show->Address from the source
window menu or double click on the line number while holding down

the shift key.
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Updating Variables

ZAP letsyou update or change the value of any variablein the current
scope.

Mouse and Menu

To update a variable, double click on the variable name and
choose Update from the pop-up window. This opensthe
Update dialog box where you can enter a new value for the
selected variable. The entry format can be changed by clicking
on the Format button and choosing the desired format from the
pop-up window. This allows you to enter the new value in any
of the following standard formats. ZAP will make any
necessary conversions.

Character - Enter the desired ASCI| character between the
apostrophes.

Octal - Enter an octal value in standard C notation with using a
leading zero.

Decimal - Enter asigned decimal value.
Unsigned - Enter an unsigned value.

Hexadecimal - Enter an hexadecimal value in standard C
notation using aleading Ox. (e.g., 0x100 for hexadecimal 100)

Sring - Enter an ASCII character string between the double
quotes.

| i

EEnl'muli Cancel

Figure 4-1 Update Dialog Box
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Command Window

The update command is used to update a variable from the
command window. The following examples demonstrate
some common uses of the update command. For more detailed
information see the update command in the* ZAP Commands”
chapter.

. Typeupdate i 3or update i=3 to update variablei
to the value of 3.

. Type update buffer “abc” to update the character
string buffer to abc.

. Typeupdatech ‘a’ to update the character variable
chtotheletter a
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Evaluating Expressions

ZAPdlowsyouto display the value of any variable or expressionina
temporary pop-up window. Thisfeature helpsavoid cluttering up the
Monitors window with variables and expressions that you only need
to display occasionally.

Evaluate Expression

There are several different ways to evaluate variables and expres-
sions. Choose any of the following methods.

Mouse and Menu

* Toevaluate avariable, double click on avariable namein
the source window and choose Evaluate from the pop-up
menul.

»  To bypass the pop-up window, double click on avariable
name while holding down the shift key.

« To evauate an expression, select the entire expression by
dragging with the |l eft button and choose Evaluate from the

pop-up Menu.
» To bypass the pop-up window, select the expression while
holding down the shift key.

Command Window

Use the eval command with the variable name or expression to
evaluate it. The following examples demonstrate some
common uses of the eval command. For more detailed infor-
mation see the eval command in the “ ZAP Commands’
chapter.

e Typeeval i toevauatethevariablei.

» Typeeval /x ito evauate the variablei in hexadecimal
format.

* Typeeval &i toevauatethe address of variablei.

» Typeeval i+l to evaluate the value of the expression “i+1"

» Typeeval /s buffer to evaluate the variable buffer asa
string.
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Displaying and Updating Memory

ZAP alowsyou to display, disassemble or modify any block of
memory. This can be done using either the Browse or View menu.
Choose M emory from the Browse Menu or the Show Menu to open
the Memory Window Configuration dialog box. This box requires
you to enter the starting address for the memory block to be
displayed. You also need to choose whether you want the contents of
the memory block disassembled (Code) or araw data dump (Data)

= Memory Window Configuration

Address: 0xE000|
Format Ok

Ogude

@ Data Cancel

Figure4-1 Memory Window Configuration Dialog Box

Disassembling Memory

Choose Code under format in the Memory Window Configuration
Dialog box and enter avalid code address in the Address box. This
will open abrowser window containing a disassembly of the
specified memory block including symbols. You can set abreakpoint
by double clicking on any memory address in the disassembly.

Displaying Memory
To produce araw data dump Choose Data under format in the
Memory Window Configuration dialog. Thiswill bring up the Data
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Configuration dialog box which is used to format the Raw data. To
configure the data display, you have the following options:

1.

Address - Enter the desired starting address or symbol for
the memory dump in the address box.

Size - Choose a convenient data size for the display. Byte,
word or long word.

Format - Choose the desired display format; Octal, decimal
or hexadecimal.

ASCII - Choose Yesto include an ASCII display next to
the memory dump. Choose No to show only the numerical

display
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Figure4-1 Data Configuration Window

Updating Memory
If you configure the display for data you can double click on any
value in the numerical or ASCII display to update. For exampleto

update address 0x00410 in the display below, double click on the
value b000 next to address 0x00410 and enter the new value.
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Figure4-1 Data Display Window

The data display can be used to fill memory with a pattern. Choose
fill from the Data display menu to open the Memory fill window. In
the memory fill window you can enter afill pattern or choose random
to have ZAP create arandom pattern. Select the data size and the
address range inthe “To” and “From” boxes. Choose verify to have
ZAP read back the filled memory and verify that it is correct. Seethe
Fill command in the chapter “ZAP Commands’ to use the command
window or debugger script to fill memory.

Memory Fill |
Size
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& Byte I Handom— -
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Figure 4-2 Data Fill Window
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Saving a Memory Dump to afile

Click on Dump in the Data Display window to save the raw memory
dump to afile. Enter the address range in the Memory Data Dump
window and enter or select afile to save the dump.

Saving Memory in S-Record for mat

Click on S-Record in the Data Display window to save the memory
dump to afilein S-Record format. Enter the addressrangein the
“From” and “To” fieldsin the Memory Data Dump window and enter
or select afile to save the S-Record.

File Hane [iastases .
[test 519 o\ doc ety iom
eaciin
=N = | &
= My Cocuments
Duci4T
= —~
Lt Pl il Tupa Diteas: Cancel
|5-F somd Filesl™ meml _:] i = il

Figure 4-3 Data Dump as S-Record Window

Display Highlights

ZAP provides a convenient way to keep track of memory modifica-
tions using colored highlights to denote memory changes. Memory
highlights are updated each time execution is halted and cleared upon
reset.
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Evaluating Assembly Symbols

ZAP alowsyou to display the value of any global symbol ina
temporary pop-up window. Double click on any global symbol in
any source window to open popup window with the following

options.

Address of

Evauate as

Update as

Set Breakpoint
Show Code

Show Data
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Displaysthe address of the symbol. You can
also get the address by holding down the
shift when double clicking on the symbol.

Displays the value of the symboal in byte,
word or long format.

Allows you to update the contents of the
symbol asa byte, word or long value.

Sets a breakpoint at the symbols address.

Displays a disassembly of the symbols
address.

Provides a data dump staring at the address
of the symbol. Alternatively hold down the
control key when double clicking on the
symbol.
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Displaying and Updating Registers

ZAP provides awindow display dedicated to the CPU registers. The
Register window allows you to display and update any of the
processor registers with a point and click. ZAP also highlights
changes to the CPU registers each time the Program Counter isincre-
mented so you can track CPU changes instruction by instruction. The
register display is updated each time program execution is halted or
after every single step.
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To open and close the Register Window, Choose Registers
from the Show menu or type ther command in the
Command Window. Seether command inthe“ZAP
Commands’ chapter for more information.

To update aregister directly ssmply double click on the
value of the register and enter a new value.

To update aregister with asymbol or function double click
on the name of the register to open the update register
window. Click on Symbol to open the Symbol Browser or
click on Function to open the Function Browser Window.
Select the desired symbol or function to update the active
register.

Figure4-1 Update Register Window
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Displaying the Sack Frame

The Stack Window displays the current stack frame and
arguments with the active function nested to the bottom of the
display. The stack display is updated each time program
execution halts. The Stack Window allows you to double click
on any function in the stack frame to open up a Source Browser
Window containing that function. To open and close the stack
Window choose Sack from the Show menu or usethe T
command. For more information about the Toggle Sack
Display command, seethe T command in the “ ZAP
Commands’ chapter.
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Figure4-1 Sack Window
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CHAPTER

5

Advanced Topics

ZAP offers several advanced features to help you optimize your C
code aswell astrack down those hard to find bugs. This chapter
includes the following sections:

¢ Program Analyzer

¢ Simulated I/OSimulating I nterrupts

¢ Execution Timing and ZAP Variables
¢ Out of Bounds Checking (Alarms)
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Program Analyzer

ZAP SIM keepstrack of MCU cycles and records each R/W cycle
and address execution. This allows ZAP to create severa useful
displays and reports including chronology, code coverage, perfor-
mance analysis, simulated source trace and variable usage.

Chronology

The Chronology feature provides achronogram or graphical time-line
of function calls or task usage. A proportional bar chart is used to
denote entry and exit from atask or function with relation to the total
number of cycles executed You can choose atask chronogram or
function chronogram. All chronograms start from reset.

Use the Reports menu to send code coverage information directly to
afile.

Choose Chronol ogy->Functions from the Analyzer menu to display a
chronogram of function calls. Functions are listed in chronological
order by the first call to the function with the most recent function
listed first.

If the application was built with a recognized kernel, Choose
Chronology->Tasks from the Analyzer menu to display a chronogram
of Kernel Task entry and exit. Tasks are listed in chronological order
by the first entry into the task with the most recent task listed first.
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Figure 5-1 Function Chronogram
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Code Coverage

ZAP SIM records all executed instructions and compares these to the
source code to create several useful displays and reports.

Use the Reports menu to send code coverage information directly to
afile.

Choose Code Coverage->Full from the Analyzer menu to open a
display window with code coverage statistics for the entire appli-
cation.

Choose Code Coverage->File from the Analyzer menu and choose a
fileto display code coverage statistics on that file.

Choose Code Coverage->Function from the Analyzer menu and
choose afunction name to display statistics for that function.

Choose Code Coverage->Uncovered Code from the Analyzer menu
and select All Files, For File, or For Function to display only unexe-

cuted code statistics for the selection.
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Figure 5-2 Code Coverage Display Window
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Performance Analysis

ZAP's performance analysis feature gives you a graphical represen-
tation of code coverage and MCU cycles. Code coverage can be
displayed on afile by file, or task by task basis. There are several
viewing and sorting options.

Use the Reports menu to send code coverage information directly to
afile.

Choose Performance->Zero to start or reset the analysis. Zero causes
the clock counter to be reset aswell as any previous function calls.

Choose Performance->View from the Analyzer menu to open a
performance analysiswindow. There are two different types of
performance windows each with different menu and display options.

File Perfor mance Window

Choose Performance->Sort by->File from the Analyzer menu
to sort performance information by file and function and
choose Performance->View to open a File Performance
Window. You can choose to sort the display by first file
entered, most function calls or time spent in functions by
clicking on the appropriate menu item. Click on refresh to
update the performance information. Double click on any
function name to display the total number of callsto the
function.
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Figure 5-3 File Performance Window
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Task Performance Window

If the application was built with a recognized kernel, Choose
Performance->Sort by->Task from the Analyzer menu to sort
performance information by kernel task and choose
Performance->View to open a Task Performance Window.
You can choose to sort the display by first entry into task, most
callsto task, or most time in the task by clicking on the appro-
priate menu item. Click on refresh to update the performance
information. Double click on any function nameto display the
total number of calls to the function.

f—
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Figure 5-4 Task Performance Window

Simulated C and Assembly Level Trace

The C Trace feature allows you to record and play back a sequence of
executed C instructions. Once recorded you can trace backwards and
forward through the trace to see exactly how the code was executed.
To use C trace simply follow the directions below.

1. Deactivate all functions that you want excluded from the
trace. Only functionsthat are active will be included in the
trace.

2. Choose C Trace->Begin from the analyzer menu to begin
the trace from the current line of C code.
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Set a breakpoint to select a convenient place to stop the
trace. Alternatively, you can use the Go Till command to
start and stop execution.

Execute the code using one of the execution commands
described in the Program Execution chapter.

Choose C Trace->Sop from the Analyzer menu to stop
recording the C trace.

Choose C Trace ->View to change to the C Trace playback
screen.  The playback screen provides several option
buttons for displaying the recorded trace. Choose any of
the following:

. Click on Forward to move forward one C linein the
trace.

. Click on Backward to move backwardsone C linein
the trace.

. Click on Continuous to start a continuous playback

from the current position.

. Click on Restart to reset the playback to the
beginning of the trace.

. Click on Quit to exit the playback screen.

You can play back the trace as many times as you want
until you either record over it or exit the debugger.
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Figure 5-7 Source Trace Playback Screen
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Variable Usage

ZAP SIM records and tracks all data accesses of global and static
program variables. Thisdisplay lists each program variable followed
by a summary of how many reads and writes were detected. The
Variable usage report also provides details of which file, function,
source line and address made the data access.

Choose Variable Usage->Full from the Analyzer menu to open a
display window with Variable Usage statistics for all variablesin the
entire application.

Choose Variable Usage->File from the Analyzer menu and choose a
fileto display Variable Usage statistics for al variablesin the
selected file.

Choose Variable Usage-> Select from the Analyzer menu and choose
aprogram variable to display statistics for just the selected variable.
Use the Reports menu to send code coverage information directly to
afile.
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Figure 5-8 Variable Usage Display
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Simulated 1/0

ZAP provides ageneral facility to perform simulated 1/0 using files
stored on your computer. Simulated 1/0 isameans by which you can
bring input right into you embedded system or send output from your
system to datafiles on your computer. These files can be created and
manipulated with standard computer utilities like spread sheets and
data bases and math programs. Embedded systems development has
always had one big problem. It isdifficult to get datainto the system
to test the algorithms until most or all of the hardware is finished.
Simulated /O bridges the gap. You can create data or stimulusfiles
that can be read into the system from anywherein the system as easily
as setting awatch point.

Simulated /O uses the fopen, fclose, fread and fwrite commandsin
conjunction with the watch point mechanism. These commands can
aso be used directly in the command window for you just want to get
or output something one time or periodically throughout a command
script.  To setup the mechanism follow the steps below.

1. Open thefilesyou want to use for simulated 1/0O using
fopen. (e.g. fopen/c:1 c:\test.out)

2. Set awatch point in your application where you want to
send or receive data. Thisisoften in afunction that reads
or writesto a hardware 1/0 register. Note the application
must be able to execute to thislocation. You may need to
set additional watch points to set some conditions so
execution will get the desired location.

a) Enter thedesired I/O command in the action box of the
watch point edit window. e.g. fwrite/c:1 “%d"var

3 Set abreakpoint to stop the application after the 1/O is
finished.

4. Execute the application to the breakpoint or till the end.

5. Closethel/O files using the fclose command. (e.g. fclose/
cl)
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In general, you'll want to create a script to setup the watch pointswith
the appropriate actions for your specific application. See the chapter
“ZAP Commands’ for details on the commands record, input,
watch, fopen, fclose, fread and fwrite.

The following example uses an input script to open two files and set
two watch points to simulate input from afile process the input using
the target processor and then output the result to afile on the host
computer.

Example

Thefile below is asimple program which reads in a couple of
integers adds them together and outputs the result to afile as
formatted text using printf.

#include <stdio.h>

int a,b,sum;
int getinput(void);
int putchar (char c);

void main(void)
{
a = getinput();
b = getinput();
sum = a+b;
printf(“ Theresult of a+b is%d \n” ,sum);
END_MAIN: ;
} // END MAIN

The following routines are dummy input and output routines. These
could be any 1/0 routines. The simulated I/O mechanism is created
by the watch points with the fread and fwrite commands. Note the
labels OUTCH and INCH. These are standard C goto labels.
Although, the goto feature in C has traditionally been taboo, using
just the labelsis useful for creating debugger breakpoints and watch-

Page 5-10
© Copyright 1999 by COSMIC Software



Advanced Topics

points. These labels are treated as local symbols and alow you to
create scripts which contain relative break and watch points within a
function. Without using such labels you would need to know which
line of the function you want to set the break and thus if you modify
the source file you may need to modify any scripts containing break-
point in that function.

NOTE

If you want to use the local 1abels (goto) described abovein a
ZAP script you need to compile with extra debug information.
Use the -xx option on the preprocessor/parser. for example
cx6812 -pxx +debug -vl aciac

Page 5-11
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Thefollowing isa ZAP input script that will load the example appli-
cation open the two 1/O files, set two watch points to perform the I/O
simulation and then execute the application. Each time the fread
watchpoint is taken the next value in thefileisread in to simulate a
flow of input. The fwrite watchpoint routine appends output to the
file and so as not overwrite the previously written information.
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Thefile data in.txt contains the following data before and after the
script is executed:

After executing the script the file data_out.txt is created and contains
the following:

If you want to simulate your hardware controlled 1/0 registers you
may need to add additional watch pointsto set the proper conditions.
For example, it iscommon in an SCI routine to loop on the transmit
enable to make sure the hardware is ready to receive a character.
When simulating the SCI you would need to either #ifdef around the
loop or set an additional watch point and set the condition. e.g.

watch putchar():SCI_LOOP {update SCSI = (SCSI » SCTE)}

Page 5-13
© Copyright 1999 by COSMIC Software



Advanced Topics

Execution Timing and ZAP Variables

ZAP SIM can be used to compute the execution time of a program or
portion of aprogram using ZAP'sinternal cycle counter. The cycle
counter is displayed in the Register window of ZAP and maintained
asthe ZAP variable“&time”. The $time variable may be used in any
ZAP command script or directly in the command window. User
defined variables may also be created using the EVAL command. All
user defined variables must be prefixed with a period.

The following example script downloads a demo file and calculates
the execution time between functions main() and sieve() and outputs
the result into the file time_data.txt. The script also creates two ZAP
variables “.start” and “.diff” to simplify the calculation.

* Remove old output file

remove time _data.txt

fopen /c:1 time data.txt

load \examples\demo12.h12

go main()

eval .start = $time

go sieve()

eval .diff = $time - .start

fwrite/c:1 " Cycletime between main and sieve() = %d" .diff
fclose/c:1

The above script creates ZAP variables “ .start” and “.diff” and atext
file named “time_data.txt” with the following contents.

Cycle time between main and sieve() = 147
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Simulating Interrupts

ZAP SIM provides ageneral mechanism to simulate interrupt sources
using an interrupt description file. Interrupt description files can be
created and customized to any specific MCU derivative. To load an
interrupt description file add it to the [Target] section of the ZAP
initialization file (.ini) located in the Windows fol der.

Choose Setup->Interrupts->Show Table to display the default vector
table. Choose Setup->Interrupts->Dump Table to save the default
vector table to afilefor editing.

Exampleentry in ZAP initialization file.
[TARGET]
Interrupts=c\TEST\interrupt_desc.int

An interrupt description file consists of the vector address, priority (if
any) and the name of theinterrupt. ZAP provides 3 different waysto
cause an interrupt.

1. Interrupt Command
2. Timer Based Interrupts (MCU Cycles)
3. Location Based interrupts

Exampleinterrupt filefor processorswithout
interrupt priorites

Interrupt File Format:

<Address of the interrupt vector> <Interrupt name>

where <interrupt name> may be any text string which will appear in
the list of available interrupts to configure viatime based or location
based interrupts. examplefile:

Oxffed IRQ2/Keypad
Oxffe2 SCI Transmit
Oxffed4 SCI Receive
Oxffe6 SCI Error

Oxffe8 SPI Transmit
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Oxffea SPI Receive
Oxffec Timer Overflow
Oxffee Timer Channel 3
OxfffO Timer Channel 2
Oxfff2 Timer Channel 1
Oxfff4 Timer Channel 0O
Ooxfff6 DMA

Oxfff8 PLL

Oxfffa IRQ1

Oxfffc SWI

Oxfffe RESET

Exampleinterrupt description file for processorswith

interrupt priorites
Interrupt Format

<Address of theinterrupt vector> <interupt_level> <Interrupt name>
where interrupt name can be any text string. examplefile:

OxffffcO 1 IRQ2/Keypad
Oxffffc4 2 SCI Transmit
Oxffffc8 3 SCI Receive
Oxffffcc 4 SCI Error
Oxffffd0 5 SPI Transmit
Oxffffd4 6 SPl Receive
Oxffffd8 7 TIM Overflow
Oxffffdc 6 TIM Channel 3
Ooxffffe0 5 TIM Channel 2
Oxffffe4d 4 TIM Channel 1
Oxffffe8 3 TIM Channel 0
Oxffffec 2 DMA

Oxfffff0 1 PLL

Oxfffff4 3 1RQ1

Oxfffff8 5 SWI

Oxfffffc 7 RESET
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Interrupt Command

You can initiate any interrupt viathe interrupt command. Simply
typethe “interrupt” command and the address or interrupt name. for
example:

Zap> interrupt @0x5000
or
Zap> interrupt TEST

The commands above assume interrupts are enabled and that ZAP's
interrupt table includes an entry “0x5000 TEST”. If interrupts need
to be enabled you can just click on the “1” bit in the register window
or update the $cc from the command window.

Time Based Interrupt Simulation

ZAP SIM maintains an MCU cycle counter which can be used to
provide a single interrupt when a certain number of cycles have been
executed or a continuous periodic interrupt at a specified interval. To
setup a Time Wise interrupt follow the steps below:

4. Choose Interrupts> Time Wise from the Setup menu to
open the Timed Interrupts dialog box.

5. Choose the desired interrupt from the Interrupt pull down
menu.

6. Enter the number of cycles at which you want the first
interrupt to occur in the box marked “First at”.

7. Enter the number of cycles between each interrupt for a
periodic interrupt or nothing for a one-time interrupt.

8. Choose Active or Suspend to set the interrupt status. The
Trigger status box (read only) contains an X if the selected
interrupt has been triggered.

a) Active- Click on Active to enable the interrupt
simulation mechanism.
b) Suspend - Click on Suspend to disable the selected
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interrupt.
3. Click on set to save the interrupt definition and status.
4. Repest steps 1-6 to set another interrupt or Click on Close

to quit the dialog box.
o Timed hlerrapis
Fuat at |III' | Cpclizz

O T —

Ao [F] Suspend [ Trigpemd O

Intompl |=1HI [2]
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Figure 5-5 Timed Interrupts Dialog Box
L ocation Based Interrupt Simulation

You can also set an interrupt to occur when execution reaches a
certain C line or assembly address. This method uses the standard
breakpoint mechanism to initiate an interrupt. Perform the following
steps to setup a L ocation Wise interrupt.

1. Choose Interrupts>Location Wise from the setup menu to
open the Location Interrupts dialog box.

2. Choose the desired interrupt from the Interrupt pull down
menu at the bottom of the dialog box.

3. Choose or enter afunction name or source file to set an
interrupt trigger for the specified interrupt on every C line
of the function or on function entry.
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a) Choose Wholeto set an interrupt trigger on every C
linein the selected function.

b) Choose On Entry to set an interrupt trigger on the entry
of the selected function.

Hit Count Box - Enter a number in the Hit Count Box to
specify the number of times the defined trigger will be hit
before the specified interrupt is actually executed.

Choose Active or Suspend to set the interrupt status. The
Trigger status box contains an X if the selected interrupt
has been triggered.

a) Active- Click on Active to enable the interrupt
simulation mechanism.

b) Suspend - Click on Suspend to disable the selected
interrupt.

Click on set to save the interrupt definition and status.

Repeat steps 1-6 to set another interrupt or Click on Close
to quit the dialog box.
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Figure 5-5 Location Interrupt Setup Dialog
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CHAPTER

6

ZAP Commands

ZAP provides an extensive command set which duplicates the
functionality of many of the mouse selections and popup windows.
The command Window can also be used to create an automated
debugging session by loading an input command file. An input
command file may contain any valid ZAP commands. This chapter
describes the ZAP commands and their syntax and includes the
following sections:

*
*
*
L 4

L 4
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Command Line Syntax

Specifying Memory Locations and Registers
User defined variables

Entering ZAP Commands

Command Descriptions
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Command Line Syntax

All ZAP commands use the following basic syntax:

<command_name> [/options] [<argument>] [<argument>]

<command_name> specifies aZAP debugger command.
Commands must be separated from its options and arguments by one
or more spaces or horizontal tabs.

<options> specifies extra options for the command. Each optionis
preceded by aforward slash (/). <options> must be placed after the
<command_name>, but before the <argument>.

<argument> specifiesan optional location within your C or assembly
language source code, a data object, an unsigned decimal integer, a
memory address, or a C language expression. The possible formsthat
<argument> can take are described below. The argument must
follow any specified options with one or more spaces or horizontal
tabs.
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Specifying Memory Locations and Registers

Many ZAP commands require or accept an <argument>. An
argument may be a constant, internal processor register, memory
location, file name and line number, function name or variable name.
The argument command language accepts many C style expressions
and operators so objects may be accessed directly or indirectly.

« Constants and Expressions
e Target processor’s registers
» Sourcefiles and Functions

« Dataobjects and Pointers

Constants and Expressions

ZAP commands accept any legal C constant and many C operators
and expressions. ZAP also accepts binary constants using the Ob
prefix notation.

Binary Constants- Ob prefix (e.g. Ob1011)

Decimal Constants - standard notation (i.e no prefix)
Hexadecimal Constants - Ox prefix (e.g. 0x1AB)
Octal Constants - O prefix (e.g. 0765)

Register Manipulation

A register specification must have the following form:

$<register_name>

where <register_name> follows the naming conventions of the
processor’s manufacturer. A register specification isidentified by its
leading $ character. You can use any CPU register listed in the
register window simply by prefixing it with a $.
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Predefined ZAP Variables

ZAP SIM supports the following predefined symbols.
$time = Free running cycle counter

The Free running cycle counter is used to display relative MCU cycle
data and calculate performance analysis reports. You can reset the
timer by writing azerotoit. e.g. x $time=0

User defined variables

ZAP alowsthe user to define any number of user defined variables.
A user defined variable is a symbol defined and recognized by ZAP
for usein expressions. A user defined symbol isalways prefixed with
the'.’ character. To create auser defined variable simply useit in an
expression. If it doesn’t exist it will be created with aninitial value of
zero. For example:

To create the variable .temp and set it equal to the constant 10 you
could write:

ZAP> eval .temp=10

To set the variable .temp equal to the program variable “varl”:

ZAP> eval .temp=varl

To create and set the variable .tmp_cc equal to the condition code
register and test .tmp_cc to seeif interrupts are enabled:

ZAP> eval .tmp_cc=$cc
ZAP> if (.tmp_cc » 0x8) mess “interrupts disabled\n”
else mess “interrupts enabled\n”

Sourcefiles and Functions.

ZAP command arguments can also be alocation specifier designating
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one or more valid lines of C or assembly language source code. A
valid line of source code is defined as any line that is associated with
an executable piece of code which iscompiled in debug. A source
line designation can have one of the following forms:

file_name:line_number - Specifiesaline number in the given source
file. e.g To set abreak point on line 55 of testt.c the command would
be:

break test.c:55

file_name: - Specifiesall executable C linesin the named sourcefile.
e.g To set abreak point on al sourcelinesin a particular source file
the command would be:

break test.c

function():line-number - Specifies aline number in the named
function. The current source fileisassumed. e.g. To set a breakpoint
on aspecific line of afunction in the current source file the command
would be:

break main():38

function() - Specifies all executable C lines in the named function.
e.g. To set abreakpoint on all source linesin a specific function the
command would be:

break main()

NOTE

Only source line numbers which correspond to actual code are
recognized by the line number specification.
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Data Objects

A location specifier for <argument> that designates a data object can
have any one of the following forms:

data_object_name - Specifiesaglobal dataobject. e.g. To evaluate
aglobal variable named bar you would type:

eval bar

file_ name:data_object_name - Specifies a static variable with file
scope. e.g. To evauate afile static variable bar when the necessary
fileis not in the current scope:

eval test.c:bar

function():data_object_name - in scope of function named. e.g. To
evaluate avariable “tmp” local to the function main():

eval main():tmp

[:]data_object_name - scope of current function. e.g. To monitor
the local variable “i” whileit isin scope:

monit i

number - explicit constant specified in any of the following formats:
hexadecimal (0x100), decimal (16), octal address (020) or binary
(0b10000)

expression - C language expression

A data object nameis an identifier currently in scope as a data object.
You can change the current scope with the move command. You can
specify adatalocation using a C expression involving register values,
variable names and values, constants and C language operators,
assuming that the result is an addressable object, described as a
LVALUE in C parlance
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Pointer Indirection

The debugger can access data objects both directly and indirectly by a
pointer, asin the C language itself.

You can specify indirection on a pointer data object only as many
times as you specify the pointer attribute in your original declaration.
If you request too many levels of indirection, the debugger prints an
error message indicating a syntax error.

You can use any C expression, referencing structure field through
pointers while you respect the correct C syntax. The expression
evaluator checks for almost the same errors that your C compiler
does.
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Entering ZAP Commands

You enter ZAP commands at the “ZAP>" prompt.

You terminate each command with a carriage return, newline, or
linefeed character. ZAP allows you to string several commands
together. To specify multiple commands in response to asingle
prompt, type each command in the usual way and separate each
command with asemicolon ‘;’ character. A whitespace character on
either side of the semicolon isoptional. ZAP splits multiple
commands on an input line and performs each operation separately,
just asif you had entered each command in response to a separate
prompt.
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Command Descriptions

All commands described are documented in a similar fashion to facil-
itate quick reference. The name of the command appears at the top
outside corner of the page on which it is described. Itsname and a
brief description of the action it performs appears at the top of the text
under the heading Name. A brief synopsis, under the heading
Syntax, describes the command syntax and the options and param-
etersit accepts. In this context, a name enclosed in angle brackets,
such as <argument>, is an element which is defined elsewhere in the
discussion or is self evident. 1n the case of multiple options, the
description of each command tells you which options may be used
together.

The character wild card character ‘*’ directly to the right of an
element denotes an <argument> that may appear one or more times.
The command del, for example, allows one or more events to be
deleted. e.g. To delete all events you would type:

del /e *

Enter all other charactersin the synopsis as shown.

A more detailed description of the command and the options and
parameters it accepts follows under the heading Function. The
default value for each option, if any, is specified here.

One or more examples follow the command explanation, under the
heading Example. The examples given are not intended to represent
the precise behavior of ZAP for any specific processor or with any
specific program.
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ZAP Commands

Thefollowing commands are availablein ZAP. Detailed descriptions
of each command follows the summary.

* - print comment

activ - activate function

break - set or modify breakpoint

deact - deactivate function

dbreak - set or modify a data breakpoint

del - delete breakpoint, monitored or user function
disa - toggle disassembly window

dump - dump memory as byte word or long

dwatch - set a data watch

eval - evaluate an expression

fclose - close an open file (as a channel) that was used for I/0
files - show source files for application loaded

fill - block fill memory

fopen - open afile (as a channel) for input or output

fread - read from an open file (channel) and update program
variables

fwrite - write to an open file (channel)

frame - dump the stack to the command window
funcs - show functions for application loaded
go - start or resume execution at the current PC

if - test program condition
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input - load a zap command file

istep - step at the disassembly level through the program
mess - print a formatted message

layout - load and save a layout file

load - load a file

mm - modify memory

monit - monitor an expression

move - move in stack frame

ostep - step over at the source level and step over function calls
output - redirect commands and resultsto afile

path - set the search path for source files

print - print a file or function

quit - quit zap

record - record a session for playback

regs - dump registers to the command window

rem - print comment

remove - deletefile

reset - execute a target reset

session - record a ZAP session which includes the layout and last file
loaded.

stack - show stack

S - step at the source level through the program (enters active
functions)

Si - step at the disassembly level through the program
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SO - step over at the source level and step over function calls

step - step at the source level through the program (enters active
functions)

T - toggle stack frames status display
tgo - start or resume execution at the current PC with C source trace

tigo - start or resume execution at the current PC with C and
Assembly source trace

u - update variable

update - update variable

vars - open a variable browser window
watch - watch an expression

wstack - toggle the stack window
wregs - toggle the register window
update - update a data object

write - save events or monitors

X - evaluate an expression

zero - clear all events, monitors or reset the processor
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*
Description

Comment

Syntax

Function

* alows you to write acomment, mainly in acommand file or a
function. The content of the remaining text up to theend of lineis
ignored by the debugger.

Example

In acommand file:

Alias- REM

Comments may be created with either the asterisk (*) or the
command rem.
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activ

Description

Activate afunction

Syntax

activ <name_list>

Function

The activ command is used to activate afunction, i.e. to make it
possible to debug it using ZAP. By default, all functions that have
been compiled for debugging are activated by ZAP. You can
deactivate a function with the deact command; to reactivate it again,
you use the activcommand. A namelist is composed of one or
several function names, with their parenthesis and :, separated by
commas. Typing astar ‘*’ instead of a <name_list> will activate all
possible functions.

Once afunction is deactivated, it behaves asif it had NOT been
compiled for debugging.

The fewer active functions, the quicker ZAP is ableto work. So once
afunction has been tested it is worth deactivating it, thus allowing
you to focus more quickly on debugging the remaining functions.

Example

To activate function fact;

ZAP> activ fact():

To activate function fact and foo:

ZAP> activ fact():,foo():
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break

Description
Set, modify or display breakpoint event

Syntax

break [/<options>] [<location>] [{<action}]

Function
The break command sets or displaysthe*breakpoint” at <location>.

A breakpoint is an event that causes execution of your program to be
interrupted so you can examine its state. You can set a breakpoint on
a C source line(s) or an absolute address. Program execution will be
interrupted when control passes to that line or address.

A breakpoint can be set on arange of linesrather than onasingleline.
Ranges of lines are specified using the *:’ character. For example if
you want to set a breakpoint on lines 20 to 35 of function main() you
would type: break main():20:35. Typing for example break
main() :34 sets abreakpoint on line 34 of main() only.

Options

/c:i<count>  can be used to specify an optional count, which
specifies the number of times the breakpoint must be reached before
it halts execution. It isthen possible for example to set a breakpoint
when a particular C line has been executed a specific number of
times.

/a | Reactivate a suspended breakpoint

/s Suspend an active breakpoint. The breakpoint isstill set, butis
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not active and will not cause execution to stop.

When ZAP reaches <location> during program execution <count>
number of times, it performs the specified <action>.

<action> can be any valid ZAP command or set of commands. The
default <action> isto stop, refresh any open windows and prompt
for command input.

If you do not specify <location>, ZAP lists al active breakpoints.
The display of a breakpoint includes various information:

(2) First the breakpoint number between parenthesis, this number will
be used to del ete the breakpoint.

(2) The <location> associated with the breakpoint.

(3) If there’s an <action> associated with the event it will be
displayed inside curly braces{}.

(4) Next ZAP displays either (User) or (Interna). This denotes
whether the breakpoint was set by the user or the debugger.

(5) Hit count and hitsleft. ZAP displaysthe count associated with the
event and the number of hits left on the event.

(6) Thelast item in the display isthe Status of the event. Theeventis
either (on) meaning the event is active and will be taken or (off)
meaning the event is suspended and will not be taken.

(user) to indicate that the breakpoint has been set by the user or
(internal) to indicate that the breakpoint has been set by ZAP itself for
performing its work; and then the count associated with the break-
point and the number of times left before the breakpoint will be taken.

Examples

To set abreakpoint at C source line 12, in function main:

ZAP>break main():12
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The debugger will display:
(xx) test.c main():12 {} (user)(count = 1, left = 1) (on)

To set abreakpoint on every C line of function lenstr()

ZAP>break lenstr()

The debugger will display
(xx) test.c lenstr():22:34 {} (user)(count=1, left=1) (on)

To set a breakpoint on any line of filemain.c

ZAP>break main.c:

The debugger will display
(xx) main.c: any line{} (user) (count =1, left = 1)

To modify the above breakpoint with a count of 4:

ZAP>break /c:4 main.c:

The debugger will display:
(xx) main.c: any line{} (user) (count = 4, left = 4) (on)

To attach an action to the above breakpoint:

ZAP>break main.c:{<action>}

The debugger will display:
(xx) main.c:any ling{ <action>} (user)(count=4, left=4) (on)

To cancel the action attached to the previous breakpoint:

ZAP>break main.c {}

The debugger will displays:

(xx) main.c: any line{} (user) (count = 4, |left=4)
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To set a code execution breakpoint at the address 0x100:

Tolist al events currently set:

To Suspend all events currently set:

To Reactivate all currently suspended events:

Z
i
O

Breakpoints can also be set using the b command line option.
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dbreak

Description

Set, modify or display a data breakpoint event

Syntax

dbreak [/<options>] <variable> [{<action}]

Function

The dbreak command sets or displays the “breakpoint” at
<variable>.

A data breakpoint is an event that causes execution of your program
to beinterrupted so you can examine its state. You can set a data
breakpoint on any accessto aglobal variable. You can choose to
break only when aread or write is detected or on any access.

Options
/a | Reactivate a suspended data breakpoint

[c:i<count>  can be used to specify an optional count, which
specifies the number of times the breakpoint must be reached before
it halts execution. It isthen possible for example to set a breakpoint
when aparticular C line has been executed a specific number of
times.

/s | Suspend an active data breakpoint
/t | Databreak type

a | Break onany access
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r Break on Read

w Break on write

When ZAP detects a specified type of memory accessat <variable>
during program execution <count> number of times, it performs the
specified <action>.

<action> can be any ZAP valid command or set of commands. The
default <action> isto enter debug mode and prompt you for
command input.

The display of a breakpoint includes various information: first the
breakpoint number between parenthesis, this number will be used to
delete the breakpoint, then the <argument> associated with the
breakpoint, second between {} the action associated with the break-
point, third either (user) to indicate that the breakpoint has been set by
the user or (interna) to indicate that the breakpoint has been set by
ZAP itself for performing itswork; and then the count associated with
the breakpoint and the number of times|left before the breakpoint will
be taken.

To suspend a breakpoint, use the /s option. The breakpoint isstill set,
but is not active.

To reactivate a suspend breakpoint, use the /a option.

To set a data breakpoint on any access of the variable “count”:

ZAP>dbreak count

The debugger will display:
(xx) count (access) {} (user)(count =1, left = 1) (on)

To set a data breakpoint on any write access to “ count”

ZAP> dbreak /t:w count
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The debugger will display
(xx) count (write) {} (user)(count=1, left=1) (on)
To set adata breakpoint on the third read access to variable “temp”

ZAP> dbreak /t:r /c:3 temp

The debugger will display
(xx) temp (read) {} (user) (count =3, left = 3)
To attach an action to the above breakpoint:

ZAP>dbreak /c:3 /t:r temp {<action>}

The debugger will display:
(xx) temp (read) {<action>} (user)(count=3, |eft=3) (on)

Example action: To attach the following action to the above break-
point which will change the value of foo to 5 onthe third timetemp is
read.

<action > = “update temp 5"

ZAP>dbreak /c:3 /t:r temp {update foo 5}

The debugger will display:
(xx) temp (read) {updatefoo 5} (user)(count=3, left=3) (on)
To cancel the action attached to the previous breakpoint:

ZAP>dbreak /c:3 /t:r temp {}

The debugger will displays:
(xx) temp (read) {} (user) (count = 3, left=3)
To list al events currently set:

ZAP>dbreak
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deact

Description

deactivate afunction

Syntax

deact <name_list>

Function

The deact command is used to deactivate afunction, By default, all
functions that have been compiled for debugging are activated by
ZAP. You can deactivate a function with the deact command; to
reactivate it again, you use the activcommand. A namelistis
composed of one or several function names, with their parenthesis
and :, separated by commas. Typing astar ‘*’ instead of a
<name_list> will activate all possible functions. Once afunctionis
deactivated, it behaves asif it had NOT been compiled for debugging.

The fewer active functions, the quicker ZAP is ableto work. So once
afunction has been tested it is worth deactivating it, thus allowing
you to focus more quickly on debugging the remaining functions.

When debugging on real hardware it is a good ideato deactivate
interrupt service routines once they are debugged to avoid getting
stuck in the interrupt routines.

Example

To deactivate function fact:

ZAP> deact fact():

To deactivate function fact and foo:

ZAP> deact fact():,foo():
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del

Description

Delete breakpoint, monitor or user function

Syntax

del [/options] <argument>

Function

The del command deactivates a function, deletes a breakpoint,
monitor or user function depending on the option used. The default
option is/eto delete an event. <argument> can be either the event
number as shown in the breakpoint->browser or the <location> used
to create the breakpoint.

Options
/e | delete one or several breakpoints or watchpaints.

<number_list> isalist of breakpoint numbers, as displayed by the
break command, separated by commas.

/m  delete one or several monitors. <number_list> isalist of
monitor numbers, as displayed in the monitor list, separated by
commas. You can remove amonitor even if it isout of scope.

You can specify an asterisks **’ as awildcard as the only argument.
In that case, al objects are deleted.

Examples
To delete dll events:

ZAP> del /e *
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To delete a breakpoint set at foo()

To set a code execution breakpoint at the address 0x100:

To delete the absol ute breakpoint above:

Page 6-24
© Copyright 1999 by COSMIC Software



ZAP Commands - disa

disa

Description

Toggle the disassembly display

Syntax

disa

Function

The disa command toggles the assembler source display window
starting at the current PC address. Assembler lines corresponding to
the current C source line are highlighted in yellow, default.
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dump

Description

dump memory to the command window and output file.

Syntax

dump /[options] [<address>] [<address>]
dump /[options] [<address>], [bytes]

Function

The dump command instructs the debugger to dump memory to the
command window and output file. ZAP accepts an address range or
a specified number of bytesfor the display. Note: ZAP will always
dump memory onewholelineat atime. i.e. ZAP will awaysdump
at least 16 bytes.

Options
/b for byte output
/w for word output
/I for long word output.
[f:<format> display format.
b Display in binary format
d Display in decimal format
h Display in hexadecimal format
o Display in octal format
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Examples
To dump memory at OX1EF to 0x200 in decimal words:

ZAP>dump /f:d /w Ox1EF 0x200

thiswill display:

Olef 17748 17442 34182 29240 09029 18006 34696 34901
01ff 21625 39253 21283 09574 21926 22050 58147 08995

To dump at least 20 bytes of memory at Ox1EF in hexadecimal
words:

ZAP>dump /f:h /w Oxlef,0x20

thiswill display:

Olef 6abb 534b 4b4c 444b 736b 6¢c6c 60d6d 636b
01ff 6b09 776f 6b6f 0977 6b65 6a66 6369 7365
020f 6866 696b 6a09 776a 646e 0977 6f70 6966
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dwatch

Description

Set, modify or display a data watch point event. A watch point isthe
same as adata break point except that when the break condition is met
and the action has completed ZAP will silently continue execution.
Watch points are useful for events where only the execution of the
actionisdesired.

Syntax

dwatch [/<options>] <variable> [{<action}]

Function

The dwatch command sets or displays the “watch point” at
<variable>.

A datawatch point is an event that causes execution of your program
to beinterrupted so an <action> can be performed. You can set adata
watch point on any accessto aglobal variable. You can choose to
break only when aread or write is detected or on any access.

Options
la | Reactivate a suspended data watch point

/ci<count>  can be used to specify an optional count, which
specifies the number of times the watch point must be reached before
the action is performed. It isthen possible for example to set awatch
point on a particular variable has been read a specific number of
times.

/s | Suspend an active data watch point
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ft: | Datawatch type
a Execute action on any access
r Execute action on Read access

w Execute action on write access

When ZAP detects a specified type of memory accessat <variable>
during program execution <count> number of times, it performs the
specified <action> and then issues a go command to continue
execution.

<action> can be any ZAP valid command or set of commands. The
default <action> isto enter debug mode and prompt you for
command input.

The display of adatawatch point includes various information: first
the breakpoint number between parenthesis, this number will be used
to delete the breakpoint, then a W to denote awatch point then the
<argument> associated with the breakpoint, third between {} the
action associated with the watch point breakpoint, fourth either (user)
to indicate that the breakpoint has been set by the user or (internal) to
indicate that the breakpoint has been set by ZAP itself for performing
its work; and then the count associated with the breakpoint and the
number of times left before the breakpoint will be taken.

To suspend a breakpoint, usethe /soption. The breakpoint is still set,
but is not active.

To reactivate a suspended watch point, use the /a option.

To set a data watchpoint on the third read access to variable “temp”
and perform an <action> then continue execution.:

ZAP>dwatch /c:3 /t:r temp {<action>}
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The debugger will display:
(xx) temp (read) {<action>} (user)(count=3, left=3) (on)

To attach the <action> bel ow action to the above breakpoint which
will change the value of foo to 5 on the third time temp is read.

Example action:

<action > = “update temp 5"

ZAP>dwatch /c:3 /t:r temp {update foo 5}

The debugger will display:
(xx) temp (read) {updatefoo 5} (user)(count=3, left=3) (on)
To list all events and their status:

ZAP>dwatch
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eval

Description

Evaluate an expression

Syntax

eval /[options] [<expression>]

Function

The eval command instructs the debugger to evaluate <expression>.
An <expression> is any combination of variables, constants and
operators following the same syntax rules as a standard C expression,
including array and structure indexing.

The expression and its result value are displayed with the type of the
result. If no option is specified, pointers and addresses are displayed
in hexadecimal, and signed and unsigned types are displayed in
decimal. You can force a specific display option using one of the
following extensions:

Options
/b for binary output.
/c  for char output.
/d  for signed decimal output.
If:i<size> forceasizeat symbol.
b  Display abyte at address of <expression>
w  Display aword at address of <expression>
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I Display along at the address of <expression>

/h | for signed hexadecimal output with no leading Ox.
/o | for octal output.

/g for no output. Thereis no display. Thisisuseful to create silent
breakpoints or user functions, when the expression is an assignment.

Is | for string output.
/u | for unsigned decimal output.

IX for hexadecimal output. The vaueis prefixed by “0x”.

Examples

To evaluate aC variable tab[i]:

ZAP>eval tab[i]

thiswill display:
tabfi] = 10

To evaluate a C structure member test.mem1:

ZAP>eval test.meml

thiswill display:
test. meml =30
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To evauate the address of the assembly variable _foo in hex where
_fooisat 0x100 and at address 0x100 is OxF:

ZAP>eval /x _foo

thiswill display the address of the symbol _foo:
_foo =0x100

To evauate a byte sized assembly variablein hex at _foo:

ZAP>eval /x /f:b _foo

thiswill display abyte at the address of _foo:
[_foo].b = OxF

Alias- X

The X command is an alias for eval.
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files

Description

List files used to build program

Syntax

files

Function

fileswill list the files that have been linked together to obtain the
program you are currently debugging. It might be helpful to check
that you have all the source files needed.

See Also

funcs

Page 6-34
© Copyright 1999 by COSMIC Software



ZAP Commands - fill

fill

Description
fill memory with specified value(s) starting at <address>.

Syntax

fill /[options] [<address>] [<address>] <value>
fill /[options] [<address>], [bytes] <value>

Function

The fill command instructs the debugger to fill memory with the
specified value or with arandom fill pattern. ZAP accepts an address
range or a specified number of bytes for the display.

Options
/b for bytefill
Iw | for word fill
/I for long word fill
I for arandom pattern fill

Iv | requires ZAP to verify thefill pattern by reading back the
memory and comparing it to the fill pattern.

Examples
To fill memory at Ox1EF to 0x200 with the 2 byte value OXAABB:

ZAP>Till /w Ox1EF 0x200 OxAABB
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To fill 40 bytes of memory starting at 0x100 with the long value
OxAABBCCDD:

ZAP>Fill /1 0x100,20 OxAABBCCDD
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fclose

Description

Closes an open 1/0O channel which in turn closes the file associated
with the channel.

Syntax

fclose /c:<number>

Function

The fclose command closes the specified 1/O channel which resultsin
the closing of the corresponding datafile. Type the “fclose’
command, followed by the channel you want to close (/c:<number>)
Where /c:<number> is required and <number> isan integral constant
corresponding to an open channel.

Example

To close channel 1, which corresponds to the file “foo.txt”:

ZAP> fclose c:1

This closes the file “foo.txt” and channel one so both can be opened
and used again

Example
To open thefile c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channél 4 can now be used by fread to bring datainto the application
from afile outside the application or fwrite to send data outside the
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program to an external file.

Toread datain from channel 4 and store the datain program variables
chland ch2.

ZAP> fread /c:4 "%d %d'chl,ch?2

Thiswill read thefirst two bytes of “c:\test\data.txt” and store themin
program variables chl and ch2 respectively.

To closethefile “c:\test\data.txt” type:

ZAP> fclose /c:4

See Also
fopen, fread, fwrite
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fopen

Description

Open afile and associate with an I/O channel for simulated input and
output.

Syntax

fopen /c:<number> <filename>

Function

The fopen command opens afile and associates it with an 1/0
channel to be used by the fread and fwrite commands. Each I/O
channel can be associated with only onefile at atime. Typethe
“fopen” command, followed by an unused I/O channel (/
c.<number>) and then alegal <filename>. Where /c.:<number>is
required and <number> is an integral constant.

Thelocal path for <fFilename> isthe ZAP executable directory.
<number> isan integral constant

The /c option is used to specify the channel to be associated with the
specified file. This option isrequired.
Options

/a Open and append to existing file if <filename> already exists.
By default, ZAP opens and overwrites the <filename> if it already
exists.
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Example

To open the file c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channel 4 can now be used by fread to bring datainto the application
from afile outside the application or fwrite to send data outside the
program to an external file.

To read datain from channel 4 and store the datain program variables
chl and ch2.

ZAP> fread /c:4 "%d %d'chl,ch?2

Thiswill read thefirst two bytes of “c:\test\data.txt” and storethemin
program variables chl and ch2 respectively.

To closethefile “c:\test\data.txt” type:

ZAP> fclose /c:4

See Also

fclose, fread, fwrite, rewind
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fread

Description

Fread from an open 1/0 channel which corresponds to afile previ-
ously opened by the command “fopen”

Syntax

fread /c:<number> “format” <expression>

Function

The fread command reads data from afile via an associated 1/0
channel and stores the data into program variables according to the
format specification. The format specification is similar to the ANSI
C scanf function. The format string is followed by zero, one or
several expressions, separated by spaces or by commas.

The format may contain symbolic characters (escape sequences) and
several conversion sequences composed with a“%’ character
followed by asingle letter. Each converter will correlateto an
expression from the command line, evaluate it, and insert it in the
output, converted as required. Fread accepts the following format
converters:

%d Dataisread asasigned decimal.

%u Dataisread as an unsigned decimal.

%Xx Dataisread as ahexadecimal value without the Ox prefix.
%0 Dataisread as an octal value without the prefixed by “0”.

%c Dataisread asasingle character. Thereis no special
replacement for control characters. They are displayed as received.
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Fread does not expect single quotes around the character.

Example

To open the file c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channel 4 can now be used by fread to bring datainto the application
from afile outside the application or fwrite to send data outside the
program to an external file.

Toread datain from channel 4 and store the datain program variables
chland ch2.

ZAP> fread /c:4 "%d %c %x''chl,ch2,inl

Thiswill read the first three bytes of “c:\test\data.txt” and store them
in program variables chl, ch2 and inl respectively. If thefile
“c:\test\data.txt” contains the following:

12 a fe
20 b ff

The first time the fread command above is executed

chlissetto 12
ch2issetto‘a
inlis set to Oxfe

The second time fread command above is executed

chlissetto 20
ch2issetto‘b’
inlis set to Oxff

ZAP will continue to increment the file pointer in order to read new
data until the end of fileisreached. If you want to start back at the
beginning of the file either rewind the channel or open and close the
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channel and file.

To closethefile “c:\test\datatxt” type:

See Also

fopen, fclose, fwrite, rewind
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fwrite

Description

Write to an open 1/O channel which correspondsto afile previously
opened by the command “fopen”

Syntax

fwrite /c:<number> “format” <expression>

Function

The fwrite command writes data from the loaded application or
directly from the ZAP command window via an associated |/O
channel. Fwrite formats the datain the output file according to the
format specification. The format specification is similar to the ANS|
C printf function. The format string is followed by zero, one or
several expressions, separated by commas. The format string may
contain symbolic characters (escape sequences) and several
conversion sequences composed of a‘ %’ character followed by a
single letter. Each converter will correlate to an expression from the
command line, evaluate it and convert it if necessary and insert itin
the output file. Fwrite command accepts the following format
converters:

%d Datais output as asigned decimal.

%u Datais output as an unsigned decimal.

%Xx Datais output as a hexadecimal value without the Ox prefix.
%0 Datais output as an octal value without the prefixed by “0”.
%c Dataisoutput asasingle character. Thereis no specia

Page 6-44
© Copyright 1999 by COSMIC Software



ZAP Commands - fwrite

replacement for control characters. They are displayed as received.
Fread does not expect single quotes around the character.

Example
To open thefile c:\test\data_out.txt and associate it with channel 4.:

ZAP> fopen /c:5 c:\test\data out.txt

Channel 5 can now be used by fwrite to output data from the appli-
cation to afile outside the application.

To write the value of program variables chl, ch2 and inl to channel 5
and thus out to “c:\test\data_out.txt”.

ZAP> fwrite /c:5 "%d %c %x''chl,ch2,inl

If the program variables have the following values when the fwriteis
executed:

chl1=25

ch2="'¢
inl=0xAB

The following will be output to “c:\test\data_out.txt":
25eAB

If the same fwrite is executed again without closing the channel then
ZAP will append to the same file. If the program was executed and
the variables have changed then the new values will be output.

ZAP will continue to increment the file pointer in order to read new
data until the end of fileisreached. If you want to start back at the
beginning of the file either rewind the channel or open and close the
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channel and file.

ZAP> rewind /c:5

To closethefile “c:\test\data out.txt” type:

ZAP> fclose /c:5

Example 2

To write the value of program variables chl and ch2 to channel 5 with
extraformatting.

ZAP>fwrite /c:5 "variables chl=%d\n ch2=%d\n" chl,ch2

If program variables ch1=5 and ch2=7 then the output file would ook
like the following:

variables ch1=5
ch2=7

See Also

fopen, fclose, fwrite, rewind
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frame

Description

List the functionsin the current stack frame with arguments.

Syntax

frame

Function

The frame command will display the functions currently in the stack
frame with their corresponding arguments. The list will be captured
in the command window and the file specified by the output
command if any.
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funcs

Description
List functions used to build program

Syntax

funcs

Function

funcswill list the functions that have been linked together to obtain
the program you are currently debugging. It might be helpful to check
that you have all the source files needed, and to know where a
particular function is located.

Functions will be displayed by sourcefile. Each function is prefixed
by aword indicating whether it is active (see active command).

(on) Indicatesthat the function is activated, but breakpoints are not
yet loaded

(act) Indicates that the function is activated, and breakpoint have
been loaded.

(off) Indicates that the function is deactivated.

Thisinformation is useful mainly for an emulator or board version,
and the effects associated with these states depends on the actual
target system.

Example
To list the functions of a specific file, type
funcs
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Produces the following output to the command window:

Functionsin file: test.c
(on) extern void main() at Oxarl

(on) externvoid init() at Oxadb

See Also

files
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go

Description

Start or Resume execution

Syntax

go [count] [<location>]

Function

The go command starts or resumes program execution. Once begun,
execution will continue until program termination or until ZAP
encounters a breakpoint. If you specify a numeric constant as an
<count>, ZAP will halt execution and prompt you for high level
command input after executing <count> source lines, provided it
encounters no breakpoints. If you specify a<location>, executionis
stopped when thislocation is reached. <location> may be any line or
object suitable for a breakpoint.

The debugger will not write its output to the screen as it steps through
your C source. The screen will only be updated when ZAP halts; this
alowsfor afaster execution of the program being simulated.

Example

The following command will execute the code starting at the current
PC until the function main() is entered.

go main(Q)

The following command will execute (simulate) 4 source lines and
then stop.

go 4
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Description

Test program condition.

Syntax

if ( <condition> ) <CMD> ; else <CMD> ;
if (<condition>){<CMD>; <CMD2>;} else{<CMD>; <CMD2>; }

Function

The if command tests a program condition and executes a ZAP
command(s) if the condition is true and can optionally execute
another ZAP command(s) if the condition isfalse. <CMD> may be
any ZAP command. Theif command can be used as part of an action
to awatchpoint.

Example

The following command will test the program variable “ count” and if
“count” is > than 25 a message will be written to the command
window and output file (if any).

if (count > 25) mess “warning count out of range”

Example 2

The following command will set awatch point at label in the main
function called “TEST_LABEL” test the value of the program
variable “zchl” and write a message out to afile open on I/O channel
1 and then continue executing.

watch main():TEST_LABEL { if (zchl < 4) fwrite /c:1
“zchl < 4\n" ; }
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input

Description

load a zap command file and start executing the commands.

Syntax

input <filename>

Function

The input command redirects command input for ZAP. Typethe
“input” command, followed by alegal file name <fi lename>, to
redirect debugger command input so that it comes from the named
file. Aninput file may contain any valid ZAP commands.

Thiscommand is useful for entering debugger input from acommand
file to provide an automated session.

The input command files continues to execute until the end of he
command file, or until another input command or the “escape” key is
pressed.

Example

To redirect input from the file demo.mac:

ZAP> input demo.mac

See Also

record, output
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interrupt

Description

Initiate a program interrupt and transfer control to the specified
interrupt vector address.

Syntax

interrupt <@address> | <interrupt vector name>

Function

Theinterrupt command is used to generate a processor interrupt.
This command accepts either the address of the vector or the vector
name as found under “ setup->interrupts->Show Table” menu item.
The interrupt command will simulate the standard CPU exception
mechanism. When an interrupt is issued ZAP will stack the appro-
priate processor registers and fetch the address from the vector
address and set the PC. The next execution command will start at the
specified interrupt address. Note the interrupt mechanism only
simulates the internal CPU and not peripheral registers or externa
memory.

Example

The following command will generate an interrupt which will vector
to the address OxFFD6 and set the PC to the address stored at
OxFFD6.

interrupt @OXFFD6

The following command will generate an interrupt at REST as
defined in ZAP under “ setup->interrupts->Show Table" ..

interrupt RESET
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istep

Description

Execute one or more assembly instructions.

Syntax

istep [<condition>]

Function

Theistep command controls how many assembly instructions of your
program ZAP executes. By default, istep executes one assembly
instruction. The <condition> associated to the ‘istep’ command can
take various forms: it can be a<count>, a specified file, arange of
linesin a specified file, a specified function, or arange of linesin a
specified function. It is then possible to instruct the debugger to step
through the program until a specified line is reached.

If you specify anumber for the <condition>, ZAP will execute the
specified number of assembler instructionsinstead. If you specify a
location for the <condition>, ZAP will execute one assembly
instruction at atime until it reaches the location. All open windows
will be refreshed after every single step.

While executing assembler instructions the disassembler window is
always open and the current machine instruction is highlighted with a
>’ character at its left.

Example

To single step 10 assembly instructions:

ZAP>istep 10
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To step assembly instructions until you reach function lenstr()

ZAP>istep lenstr()

To step assembly instructions until you reach any linein file main.c

ZAP>istep main.c:

To step assembly instructions until you reach line 45 of put()

ZAP>istep put():45

Alias- Thesi commandisan aliasfor istep. You may also click on
theletter ‘s whilethe disassembly window isactiveto instruction

step.
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layout

Description

Load or Save the current ZAP layout to afile.

Syntax

layout /{<options>] <filename>

Function

The layout command loads or saves a ZAP windows layout from/to
<filename>. A layout contains the type of windows (cascade, tile or
free) and the following windows if open:

Command window - saves/loads size and location of the window
Register window - saves/loads size and |ocation of the window
Source window - saves/loads size and |ocation of the window
Disassembly Window - saves/loads size and location of the window
Stack Window - saves/loads size and location of the window

Monitor Window - saves/|oads the size and location of the window.
Options
/l Load a ZAP layout.

Is  SaveaZAP layout (default).
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Example

To save a ZAP layout:

ZAP>layout /s projectl._lyt

See Also

record, session
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load

Description
Load file

Syntax

load [/<options>] <File>

Function

Theload command is used to load afile. Theloading happens
exactly asif thefile had been specified from the file menu of the ZAP.
The PC is set to the address of the symbol __stext, which istypicaly
defined in the crts run time startup routine and used for the reset
vector. If thissymbol is not found, ZAP will set the PC to the first
address of the first .text segment. Any previously loaded files are
completely lost.
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mess

Description

Print aformatted message

Syntax

mess “format” <expression>

Function

The mess command displays a character string, including values
converted from expressions. This command acts as the C function
printf. The format string is followed by zero, one or several expres-
sions, separated by spaces or by commas.

The format may contain symbolic characters (escape sequences) and

several conversion sequences composed by a‘ %' character followed

by asingle letter. Each converter will correlate to an expression from
the command line, evaluate it, and insert it in the output, converted as
required. Converters are the following:

%d Theresult isconverted to signed decimal.

%u  Theresult is converted to unsigned decimal.

%X Theresult is converted to hexadecimal, prefixed by “0x”.
%0 Theresult is converted to octal, and prefixed by “0”.

%c | Theresult isdisplayed as asingle character. There is no special
replacement for control characters. They are displayed as received.
There are no single quotes around the character.
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%s if theresult isan array of char or a pointer to char, the string
pointed at is displayed until aterminating NUL character is reached.
There are no double quotes around the string, but control characters
are mapped into their symbolic C representation.

Example 1

To print the program variable tab[i]:

ZAP> mess “tab[%d] = %x\n” i,tab[i]

the following is output to the command window:
tab[2] = 0x10

Example 2

To print avariables and it’s address on two separate lines:

ZAP> mess “varl=%d \n &varl=%x\n” varl,&varl

the following is output to the command window:
varl=3
&varl=0x60

See Also

fwrite
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mm

Description
Modify memory at address.
Syntax

mm [/<options>] <address> <value>

Function

The mm command modifies the memory at <address> by storing
<value> init. <address> must be avalid addressin memory (RAM)
and <value> must be an absolute expression i.e. anumber. This
command displays the old and new value at the specified address.

b | Modify one byte at address (default).
W Modify one word (2 bytes) at address.

I Modify one long word (4 bytes) at address.

Example
To modify one byte of memory at 0x100 with the value of 3:

ZAP>mm /b 0x100 3

or

ZAP>mm 0x100 3

To modify one word at address 0x100 with the value 0x200:

ZAP>mm /w 0x100 0x200
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monit

Description

Monitor an expression

Syntax

monit /[options][<expression>]*

Function

The monit command instructs the debugger to start monitoring the
value(s) specified by <expression>. When you specify several
expressions, they must be separated by commas.

Monitoring consists of displaying the updated value of the specified
expression every time the debugger prompts for more input. The
expression is displayed only when in scope.

To stop monitoring, use the del /m command, giving it the number of
the monitor.

By default, pointers and addresses are displayed in hexadecimal,
while signed or unsigned types are displayed in decimal.

You can force a specific display format by using one of the following
extensions:

Options
/d | force signed decimal outpuit.
/u  force unsigned decimal output.

/x| force hexadecimal output. The value is prefixed by “0x”.
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/o  force octal output. The valueis prefixed by “0”.

Ic  force character output. The result is displayed as a character
between simple quotes. If it isacontrol character, it isreplaced by its
symbolic C representation

Is | force string output. If the expression evaluates as a character
pointer or an array of characters, the pointed string is displayed
between double quotes. Control characters are replaced by their
symbolic C representation.

If you specify an already existing monitor, the new specification will
be used to update the display format.

Example

To monitor variable ac, type:

ZAP>monit ac

thiswill cause the following result to be displayed in the monitor
window:

(1) ac =3 to be displayed.

To monitor ac in hexadecimal:

ZAP>monit /x ac

thiswill cause the following result to be displayed in the monitor
window:

(1) ac=0x3

To monitor variables i and j, type:

ZAP> monit i
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followed by:

or more simply:

To remove the second variable in the monitor window type:

Alias-m

The m command is an alias for monit.
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move

Description

Movein stack frame

Syntax

i <direction>[<address> ]

Function

The move command changes the scope of the C source you are
inspecting in increments of “stack frames’. Move followed by a
direction option moves the window up or down one or more stack
frames in the direction you specify. Stack frames are the regions of
storage that the compiler alocates and deallocates from the region of
storage known as the “ stack.” A stack frame holds the calling
environment of the expression that called the executing function, the
argument data objects passed on the function call, and al of the data
objects declared within the function that have dynamic lifetimes. You
direct movement of the scope by specifying:

Options

=

to move up one stack frame,
d to move down one stack frame,

t  to moveto the top stack frame,

o

to move to the bottom stack frame.
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The function mainis usually at the top of the stack. If you specify an
address <address>, ZAP moves the window as many frames as

necessary to get to a stack frame that is in scope for that address.

See Also

stack, frame
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output

Description

Capture ZAP command window output.

Syntax

output <filename>

Function

The “output” command is used to capture all command responses
from ZAP. To close an output file simply type “output” on aline by
itself. By default, ZAP opens a new file each time the output
command is used with a <filename> and overwrites any previousfile
of thesamename. Only one output file can be open at any onetime.
If a second output command isissued while another file is open the
first fileis closed and the second file is opened and starts capturing
output.

This command is useful for saving debugger output in afile for
inspection or for comparing it with the results of a previous session.

The “output” redirection stops when the command ‘output’ is entered
without an argument. The “escape”’ key does not stop output
redirection.

Options

la | Append to the output file.

Output is always echoed onto the screen, and only the results of
commands displayed in the command window and the output file.
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Example

To save the output of the debugger infile res.out:

ZAP> output res.out

See Also

input, record
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ostep

Description

Execute one or more source lines and step over function calls.

Syntax

ostep <condition>]

Function

The ostep command controls how many source lines of your program
ZAP executes. By default, ostep executes one source line of code and
steps over asource lineif it'safunction call.

The <condition> associated to the ‘ ostep’ command can take various
forms: it can be a<count>, a specified file, arange of linesina
specified file, a specified function, or arange of linesin a specified
function. It isthen possibleto instruct the debugger to step through
the program until a specified lineis reached.

If you specify a number for the <condition>, ZAP will execute the
specified number of source lines, but will not trace into functions. If
you specify alocation for the <condition>, ZAP will execute one
source line at atime until it reachesthe location. All open windows
will be refreshed after every single step.

While executing source lines the source window is always open and
the current source line is highlighted with a‘>’ character at its left.

Example

To single step 10 source lines in the current function without entering
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any called functions:

ZAP>ostep 10

To step one source line at atime in the current function without
entering any called functions until you reach line 45 of put() whichis
assumed to be the current function.

ZAP>ostep put():45

Alias- s0
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path

Description

Set the search path for ZAP to locate application source files for
display.

Description

The path command is used to set the search path for ZAP application
files.

path <PATH1|PATH2>

The path sets and displays the current search path that ZAP will use
to locate application source files. To display the current path simply
type path.

Example

To set the search path to “c:\source”, type:

ZAP>path “c:\source”

ZAP will now search only “c:\source” to find application source files.

To set the search path for ZAP to search “ c:\source” and then search
“c:\work”, type:

ZAP>path “c:\source]c”\work”

ZAP will now search “c:\source” first and then if it doesn’t find the
fileit will search c:\work.
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print

Description

Print object

Syntax

print <object>

Function

The p command prints an object which can be either afile or function
or a specified number of linesin afile or function.

Options
a Display address and disassembly with the source code.

p Include performance statistics with source code.

Example

To print al of crtsi.swith addresses and disassembly

ZAP>print /a crtsi.s:

To print function main()

ZAP>print /a main():

To print lines 30 to 45 in file main.c with addresses and disassembly

ZAP>print /a main.c:30:45
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To print function main() with performance statistics

ZAP>print /p main():
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quit

Description
Quit the debugger

Syntax

quit

Function

To end a debugging session without stepping through to program
termination, simply enter quit.

quit terminates program execution and exits to the host environment
immediately.
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record

Description

Record all ZAP commandsto afile for playback.

Syntax

record <filename>

Function

The record command saves all commands entered in the command
window or created viathe mouse. The resultant record file can then
be used as input to the command window to replay a previous
debugging session. Typethe“record” command, followed by alegal
file name <filename>. The record command continues to record to
the same file until arecord command is issued without a filename.
The " escape” has no effect on the record command.

NOTE

Not all mouse actions can trandated to command line input
therefore some actions may not be recorded.

Example

To record ZAP commands to the file “test.rec”:

ZAP> record test.rec

When you want to stop recording and close the record file “test.rec”
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just type record by itself in the command window:

ZAP> record

After therecord fileis closed you can replay the recorded commands
it by using the record file as input to the command window:

ZAP> input test.rec

See Also

input, output
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regs

Description

Dump processor registers to the command window and/or output file.

Syntax

regs

Function

‘regs isused to capture the processor registersto afile or view them
on the screen. The register dump from the regs command is automat-
ically captured by an output file if one has been opened by the
“output” command. The register dump is always echoed to the
command window.
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rem
Description
Comment
Syntax
Function

rem allows you to write a comment, mainly in acommand file or a
function. The content of the remaining text up to the end of lineis
ignored by the debugger.

Example

In acommand file:

Alias-*

Comments may be created with either the asterisks or the command
rem.
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remove

Description

Remove afile from the ZAP command window or input file.

Syntax

remove <filename>

Function

The remove command del etes the specified file from your system.
Type the “remove” command, followed by a <filename> including
the full path. Thelocal path for <fi lename> isthe ZAP executable

directory.
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reset

Description
Reset the processor and set the PC to the reset vector address.

Syntax

reset

Function

Thereset command will perform a processor reset. ZAP will saveall
breakpoints and monitors during areset. In simulation, all CPU
registers are set to the appropriate reset values and the reset vector
address is|oaded into the $PC. In hardware versions of ZAP, the
emulator or processor itself isreset so al reset conditions are
generated through the hardware.

Example

To reset the processor:

ZAP>zbm

See Also

Z€ero
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rewind

Description

Rewinds the specified channel. This command resets the file pointer
in the file associated with the channel causing the next fread (after a
rewind on the same channel) to start reading from the beginning of
thefile.

Syntax

rewind /c:<number>

Function

The rewind command is used to force the fread function to read from
the beginning of an open file. By default, fread will increment it's
file pointer each time it is executed with the same open file. The
rewind command is equivalent to an fclose and an fopen of the same
file and channel.

Example

To rewind channel 1, which corresponds to the file “foo.txt”:

ZAP> rewind /c:1

This sets the file pointer back to the beginning of the file so that the
next fread of this channel will get data from the start of thefile.

See Also

fopen, fclose, fread, fwrite
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sSession

Description

Load or Save a session to afile.

Syntax

session /{<options>] <filename>

Function

The session command loads or saves a ZAP session from/to
<filename>. A session contains the search path for sourcefile, the
last file loaded, the type of windows (cascade, tile or free) and the
following windows if open:

Command window - saves/|oads size and location of the window
Register window - saves/loads size and |ocation of the window
Source window - saves/loads size and location of the window
Disassembly Window - saves/|oads size and location of the window
Stack Window - saves/loads size and location of the window

Monitor Window - saves/|oads the size, ocation and contents of the
window.

Data Window - saves/loads the size, location and starting address of
the window.

Options
/l Load a ZAP session.

Is | SaveaZAP session (default).
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Example

To save aZAP session:;

ZAP>session /s projectl_ssn

See Also

record, layout
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stack

Description

List known stack frames

Syntax

stack

Function

The stack command displays a complete list of known stack frames
from the current stack frame to the top stack frame (usually your
program’s “main” routine). Function arguments are displayed inside
the function braces.

Example

To display the current stack frame:

ZAP> stack

The following is output to the command window:

main( )
foo(12,34)
bar(50,30)
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step

Description

Execute one or more source lines

Syntax

step <condition>]

Function

The step command controls how many source lines of your program
ZAP executes. By default, step executes one source line of code.

The <condition> associated to the ‘step’ command can take various
forms: it can be a<count>, a specified file, arange of linesin a
specified file, a specified function, or arange of linesin a specified
function. It isthen possible to instruct the debugger to step through
the program until a specified lineis reached.

If you specify a number for the <condition>, ZAP will execute the
specified number of sourcelines. If you specify alocation for the
<condition>, ZAP will execute one source line at atime until it
reachesthe location. All open windows will be refreshed after every
single step.

While executing source lines the source window is always open and
the current source line is highlighted with a‘>" character at its left.

Example

To single step 10 source lines:

ZAP>step 10
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To step one source line at atime until you reach function lenstr()

To step one source line at atime until you reach any linein file main.c

To step one source line at atime until you reach line 45 of put()

Alias-s

The scommand is an aliasfor step.
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tgo

Description

Start or Resume execution with C trace

Syntax

tgo [count] [<location>]

Function

The tgo command starts or resumes program execution. Once begun,
execution will continue until program termination or until ZAP
encounters a breakpoint. If you specify a numeric constant asa
<count>, ZAP will halt execution and prompt you for command input
after executing <count> source lines, provided it encounters no
breakpoints. If you specify a<location>, execution is stopped when
thislocation isreached. <location> may be any line or object suitable
for a breakpoint.

The debugger will not write its output to the screen asit steps through
your C source. The screen will only be updated when ZAP halts; this
allows for afaster execution of the program being simulated.

Example

The following command will execute the code and record a C trace
starting at the current PC until the function main() is entered.

tgo main(Q)

The following output is echoed to the command window and
recorded to an output file if open.

sim_io.c:10 | int putchar(char ¢)
sim_io.c:17 | return (c);
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sim_io.c:10 | int putchar(char c)
sim_io.c:17 | return (c);
sim_io.c:10 | int putchar(char c)
sim_io.c:17 | return (c);
sim_io.c:10 | int putchar(char c)
sim_io.c:17 | return (c);

bus _state analyzer.c:49 | result=getchar();
sim_io.c:27 | int getchar(void)
sim_io.c:32 | return (c);

bus_state analyzer.c:54 | init();
bus_state analyzer.c:84 | void init(void)

The following command will execute (simulate) 4 source lines and
record the C trace and then stop.

tgo 4
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tigo

Description

Start or Resume execution with C and assembly trace

Syntax

tigo [count] [<location>]

Function

Thetigo command starts or resumes program execution. Once begun,
execution will continue until program termination or until ZAP
encounters a breakpoint. If you specify a numeric constant asa
<count>, ZAP will halt execution and prompt you for command input
after executing <count> source lines, provided it encounters no
breakpoints. 1f you specify a<location>, execution is stopped when
thislocation isreached. <location> may be any line or object suitable
for a breakpoint.

The debugger will write the C and assembly instructions executed to
the command window and output file (if any).

Example

The following command will execute the code and record a C and
assembly trace starting at the current PC until the function main() is
entered.

tigo init():

The following output is echoed to the command window and
recorded to an output file if open.

sim_io.c:32 | return (c);
cc...IN.. abahx:0448 sp:0447 pc.Obab Ida ,x
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cc...l.Z. aba hx:0400 sp:0447 pc:0ba7 clrx
cc...l.Z. abahx:0400 sp:0449 pc:.0ba9 ais #2
cc...l.Z. abahx:0400 sp:044b pc:0a83 rts

cc:..IN.. abahx:0400 sp:044b pc:0a86 sta _result

bus_state analyzer.c:54 | init();
cc...IN.. abahx:0400 sp:0449 pc.0af0 bsr _init
bus_state analyzer.c:84 | void init(void)

The following command will execute (simulate) 4 source lines and
record the C trace and then stop.

tigo 4
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update

Description
Update a data object

Syntax

update [/<options>] <variable>[=]<value>
update [/<options>] <variable>[=]<const_expression>

Function

The update command updates a data object <variable> by storing a
new value <value> init. <variable> isan expression providing an
updatable location, such as a C language LVALUE, and <value> is
an expression whose result will be copied into the described location.
This command displays the old and new value associated with the
location descriptor. You can enter afull expression that will be
evaluated. The result will be transferred into the updatable location.

The ‘=" signisonly mandatory when the <value> startswith an
unary operator; for example when <value> is+1 or -2.

If <argument> isan array of char, or apointer to char, itispossibleto
set the string pointed at by the following syntax:

update <argument> <string>

where <string> is either astring constant written between two double
guotes, i.e. “hello”. The character string followsthe samerulesasaC
character string, except for the terminating NUL. You can use
symbolic representation for control characters (escape sequences).
The string is not terminated by aNUL character. If you want to do so,
you have to specify it explicitly by a\O.
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Example

To update an integer:

o

r

unsignedinti 2=>3
To update an integer with a negative value:

o

r

This command copies the string “abc” with aterminating Nul
character to terminate the string.

Alias-u
The u command is an alias for update.
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vars

Description

Open aglobal variable browser window.

Syntax

vars [<options>]

Function

The var s command is used to open a dynamic variable browser
window. Thiscommand is equivalent to selecting
“Browse->Variables->in global list” from the pull down menu. Each
command will open anew window.

Options

la | Display address of variablesin the window. The /v and the /a
option together are equivalent to the “ browse ->variables->format-
>full” pull down menu item.

Iv Display the variables valuein thewindow. The/v optionis
equivalent to “browse -variables->format->standard” pull down
menu items.

See Also

monit
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watch

Description

Set, modify or display awatch point event. A watch point isthe same
as a break point except that when the break condition is met and the
action has completed ZAP will silently continue execution. Watch
points are used for events where only the execution of the actionis
desired.

Syntax

watch [/<options>] [<address_range>][{<action}]

Function

The watch command sets or displays the “watch point” at
<address range>.

A watch point is an event that causes execution of your program to be
interrupted so an <action> can be performed. You can set a break-
point on any C source line. Program execution will be temporarily
interrupted when control passes to that line.

A watch can also be set on arange of linesrather than on asingleline.
Ranges of lines are specified using the *:’ character. For example if
you want to set awatch point on lines 20 to 35 of function main() you
would type: watch main():20:35. Typing for example watch
main() :34 sets awatch point on line 34 of main() only.

Options
/la  Reactivate a suspended watch point

Ici<count>  can be used to specify an optional count, which
specifies the number of times the watch point must be reached before
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the action is performed. It isthen possible for example to set awatch
point when aparticular C line has been executed a specific number of
times.

/s Suspend an active watch point

<action> can be any ZAP valid command or set of commands. The
default <action> isto enter debug mode and prompt you for
command input.

The display of awatch point includes various information: first the
watch point number between parenthesis, this number will be used to
delete the watch point, then the <argument> associated with the
watch point, second between {} the action associated with the watch
point, third either (user) to indicate that the watch point has been set
by the user or (internal) to indicate that the watch point has been set
by ZAP itself for performing its work; and then the count associated
with the watch point and the number of times |eft before the watch
point will be taken.

To suspend awatch point, use the /s option. The watch point is still
set, but is not active.

To reactivate a suspended watch point, use the /a option.

To set awatch point on the third execution of line 13 in thefilemain.c
and perform an <action> then continue execution.:

ZAP>watch /c:3 main():13 {<action>}

The debugger will display:
(xx) main.c:13 {<action>} (user) (count=3, left=3) (on)

To attach the <action> below action to the above watch point which
will change the value of foo to 5 on the third time line 13 of main.cis
executed and then ZAp will continue execution.

Example action:
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<action > = “update temp 5"

ZAP>watch /c:3 main.c:13 {update foo 5}

The debugger will display:
(xx) main.c:13 {updatefoo5} (user) (count=3, left=3) (on)
Tolist al the events currently set:

ZAP>watch
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Wregs

Description

Toggle the register window

Syntax

wregs

Function

‘wregs’ isused to open and close the register window. The register
window when open, will be updated every time the debugger prompts
for anew command, or when you are stepping through your program.
Theregister display includes all registers of the target processor, and
the MCU cycle counter. You can double click on any register name
or value in the register window to change the value.

See Also
regs
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Write

Description

Write componentsto afile

Syntax

write /{<options>] <filename>

Function

Thewrite command writes afile <filename> containing user defined
components of ZAP. The result isatext file that you can display or
edit as you would any text file on your host system. Thisfile may be
reloaded using the input redirection command of ZAP.

Options allow you to save selectively breakpoints, monitors, user
functions and function keys:

le Saveall user events.

/m  Save monitors.

If no option is specified, al components are saved.

The*“write” command opens and overwrites the named file each time
itisused. Sodo not create afile that has the same name as another
filein your current working directory.

Example

To save the breakpoints only to the file savl:

ZAP>write /e savl
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See Also

input, output
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wstack

Description

Toggle stack frame window

Syntax

wstack

Function

wstack is used to open and close the stack window. When the stack
window is open it is updated when execution stops.
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Zero

Description
Zero out al events, monitors or issue a processor reset.

Syntax

zero /[<options>]

Function

zer o will reset the debugger and restart the execution of the appli-
cation from the same entry point asin the original loading. The
program counter is moved to the entry point, leaving al other
registers, including the stack pointer, unchanged.

Options

le  Zero (delete) all eventsincluding breakpoints and watch
points.

/m Zero (delete) all monitored variables from the monitor
Window.

Ir  Reset the processor

Example

To remove al breakpoints, all monitors and reset the processor.:

ZAP>zero /e /m /r

See Also
reset, del
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